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Avant-propos 

Ce manuel est le support principal des travaux pratiques de télédétection spatiale du cours 
de télédétection spatiale dispensé sur le Campus d’Arlon Environnement, Université de 

Liège, Belgique. 
 

Ce manuel est téléchargeable gratuitement à l’adresse web : 
http://orbi.ulg.ac.be/handle/2268/143553 

Les données associées à ces travaux pratiques ne sont disponibles que pour les étudiants 
inscrits à ce cours. Le logiciel principalement utilisé dans ce TP est un logiciel payant (ENVI, 

de la firme EXELIS). Les autres logiciels utilisés sont gratuits et disponibles sur le web. 
 

Pensez à l’environnement avant d’imprimer ces notes!!** 
 

Ce manuel a été rédigé par Antoine DENIS 
Université de Liège (ULIEGE) 

Arlon Campus Environnement 
Département des Sciences et Gestion de l’environnement 

Unité Eau Environnement Développement (EED) 
 Avenue de Longwy, 185 

6700 Arlon, Belgique 
Antoine.DENIS@ULIEGE.be 

 
Merci de signaler toute erreur rencontrée dans ce manuel par email à l’adresse ci-dessus. 

Les mises à jour de ce manuel seront disponibles via l’adresse web ci-dessus. 
 

Version du 23 octobre 2019. Version provisoire. Amélioration et mise à jour partielle par 
rapport à la version du manuel de 2016. 

 
Sont également disponibles, du même auteur, les manuels de Travaux Pratiques : 

 SIG - QGIS (le logiciel SIG gratuit de référence  
http://orbi.ulg.ac.be/handle/2268/190559 (2016) 

 SIG - ArcGIS https://orbi.ulg.ac.be/handle/2268/135775 (2012) 
 

Images de couverture : images extraites du livre « EARTH as ART », NASA disponible à l’adresse 
http://www.nasa.gov/connect/ebooks/earth_art_detail.html et vue d’artiste du satellite « Sentinel 2 ». 

 
* Comment citer ce manuel ? : « Travaux Pratiques de télédétection spatiale, Antoine DENIS, 2013, Arlon 

Campus Environnement, Université de Liège, Belgique ». 
 

** N’imprimez pas ces notes ! Si vous devez les imprimer, utilisez le verso de feuilles déjà utilisées, imprimez 
recto-verso et/ou imprimez en 2 pages par feuilles. 

http://orbi.ulg.ac.be/handle/2268/143553
https://www.eed.uliege.be/cms/c_4961023/fr/eed-equipe
https://www.uliege.be/cms/c_8699436/fr/portail-uliege
https://www.campusarlon.uliege.be/cms/c_3973705/fr/portail-arlon
https://www.campusarlon.uliege.be/cms/c_3973705/fr/portail-arlon
https://www.eed.uliege.be/cms/c_4745185/fr/portail-eed
mailto:Antoine.DENIS@ULIEGE.be
http://orbi.ulg.ac.be/handle/2268/190559
https://orbi.ulg.ac.be/handle/2268/135775
http://www.nasa.gov/connect/ebooks/earth_art_detail.html
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1 Objectifs du manuel 

Ce manuel présente une série d’exercices simples à réaliser dans le cadre d’une première 

approche de la télédétection spatiale.  

Dans le cadre de ce manuel, vous serez initiés à la pratique de la télédétection spatiale. En 

particulier, ce manuel vise à vous rendre capable de réaliser les opérations suivantes : 

 Visualiser en 2D et en 3D des images issues de la télédétection spatiale 

 Comprendre et expliquer différents types d’images : 

o Résolutions 

o Format 

o Signification dans le monde réel 

o … 

 Manipuler différents types d’images à l’aide de différents logiciels spécialisés:  

o Images multispectrales et hyperspectrales 

o Images basse et haute résolutions spatiales 

o Images mono et multi-temporelles 

 Produire de nouvelles informations à partir de traitements appliqués sur des images:  

o Calcul d’indices spectraux 

o Analyse de changement temporel 

o Classification d’image en vue de la réalisation d’une carte d’occupation du sol 

o Correction géométrique d’images 

o … 

 Rechercher des images satellites sur le web 
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2 Notions de télédétection - Rappel théorique 

2.1 Définition 

La télédétection (détection à distance, Remote Sensing (RS) en anglais) désigne, dans son 

acception la plus large, la mesure ou l'acquisition d'informations sur un objet ou un 

phénomène, par l'intermédiaire d'un instrument de mesure n'ayant pas de contact avec 

l'objet étudié (Figure 1).  

C'est l'utilisation à distance (par exemple, d'un avion, d'un engin spatial, d'un satellite ou 

encore d'un bateau) de n'importe quel type d'instrument permettant l'acquisition 

d'informations sur l'environnement. On fait souvent appel à des instruments tels 

qu’appareils photographiques, lasers, radars, sonars, sismographes ou gravimètres.  

 

Figure 1 : Principe de la télédétection spatiale (Source : http://www.alertes-meteo.com/) 

 

http://fr.wikipedia.org/wiki/Satellite_artificiel
http://fr.wikipedia.org/wiki/Bateau
http://fr.wikipedia.org/wiki/Environnement
http://fr.wikipedia.org/wiki/Laser
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar
http://fr.wikipedia.org/wiki/Sismographe
http://fr.wikipedia.org/wiki/Gravim%C3%A8tre
http://www.alertes-meteo.com/
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L’on distingue en général les moyens de télédétection « actif » et « passif » (Sources : André 

Ozer) 

 Télédétection passive: enregistrement du rayonnement naturel, fourni par la lumière 

ou la chaleur, qu’il soit émis, réfléchi ou réfracté (ex : photographies aériennes du 

paysage éclairé par la lumière du soleil ainsi que certaines images satellitaires comme 

(SPOT, LANDSAT, IKONOS,…) 

 Télédétection active : enregistrement du rayonnement que réfléchit l’objet ou le 

paysage « illuminé » par l’opérateur (ex : images radar) 

La télédétection spatiale, dans le domaine de l'astronautique, est l'ensemble des 

connaissances et des techniques utilisées pour déterminer les caractéristiques de la surface 

et de l'atmosphère de la Terre ou d'une autre planète, par des mesures effectuées à partir 

d'un engin spatial évoluant à distance convenable de cette dernière. Le terme correspondant 

en anglais est « remote sensing from space ». 

2.2 Principe 

Ce type de méthode d'acquisition utilise normalement la mesure des rayonnements 

électromagnétiques émis ou réfléchis des objets étudiés dans un certain domaine de 

fréquence (infrarouge, visible, micro-ondes - Voir Annexe 5). Ceci est rendu possible par le 

fait que les objets étudiés (plantes, maisons, surfaces d'eau ou masses d'air) émettent ou 

réfléchissent du rayonnement à différentes longueurs d'onde et intensités selon leur état. 

Certains instruments de télédétection utilisent des ondes sonores de façon similaire, et 

d'autres mesurent des variations dans des champs magnétiques ou gravitaires. 

2.2.1 Réflectance solaire 

La réflectance solaire se définit comme le rapport entre l'énergie solaire réfléchie et 

l'énergie solaire incidente sur une surface (Energie Solaire Réfléchie / Energie Solaire 

Incidente (Figure 2). Par exemple, une réflectance de 100% signifie que la surface en question 

réfléchit toute l'énergie solaire dans l'atmosphère et n'en absorbe aucune fraction. 

 

http://fr.wikipedia.org/wiki/Astronautique
http://fr.wikipedia.org/wiki/Terre
http://fr.wikipedia.org/wiki/Plan%C3%A8te
http://fr.wikipedia.org/wiki/Engin_spatial
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Figure 2 : Principe de la réflectance solaire 

2.3 Exemples d’applications 

Les exemples d’applications de la télédétection spatiale sont très nombreux : 

 La production de cartes d’occupation du sol 

 Le suivi des conditions de végétation 

 Le suivi de la température de surface (eau et continent), de la fonte des glaces, du 

niveau des mers, etc 

 Les cartes topographiques sont souvent produites à l'aide de paires stéréographiques 

de photos aériennes permettant de recréer une image en trois dimensions.  

 Les modèles numériques de terrain peuvent être produits par interférométrie, 

méthode consistant à enregistrer une série de mesures de la cible à partir d'un avion, 

d'un satellite ou d'une navette spatiale. La combinaison des données issues de ces 

mesures offre une carte détaillée contenant de l'information sur la couverture du sol, 

le relief ou encore le mouvement à une échelle centimétrique. Les données couvrent 

généralement des bandes de plusieurs kilomètres de largeur.  

 Les précipitations, les aéronefs et les navires peuvent être détectés par radars.  

 Les fonds marins sont cartographiés grâce à l'usage des sonars. 

 … 

http://fr.wikipedia.org/wiki/Carte
http://fr.wikipedia.org/wiki/St%C3%A9r%C3%A9ographie
http://fr.wikipedia.org/wiki/Interf%C3%A9rom%C3%A9trie
http://fr.wikipedia.org/wiki/Avion
http://fr.wikipedia.org/wiki/Satellite_artificiel
http://fr.wikipedia.org/wiki/Navette_spatiale
http://fr.wikipedia.org/wiki/Pr%C3%A9cipitation
http://fr.wikipedia.org/wiki/A%C3%A9ronef
http://fr.wikipedia.org/wiki/Navire
http://fr.wikipedia.org/wiki/Radar
http://fr.wikipedia.org/wiki/Sonar


 11 

   

Figure 3 : Quelques exemples d’application de la télédétection spatiale : carte d’occupation du sol, 
suivi des conditions atmosphériques, réalisation de modèles numériques de terrain (MNT) 
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3 Introduction au TP avec « Google Earth Pro » 

« Google Earth Pro » est probablement la plus belle application de la télédétection spatiale 

réalisée à ce jour. Connectez-vous à internet.  

Installation de Google Earth Pro sur votre ordinateur 

 Téléchargez Google Earth Pro à 

l’adresse http://www.google.fr/intl/fr_ALL/earth/versions/ (en bas de page : 

« Télécharger Google Earth Pro sur ordinateur ») 

 Installez Google Earth Pro en exécutant le fichier téléchargé 

 Démarrez Google Earth Pro (une connexion internet est nécessaire).  

 

 

 

 

 

 

Exploration de Google Earth Pro 

 Localisez le Campus d’Arlon et en particulier le bâtiment de la salle informatique. 

 Cochez l’option « Relief » dans le panneau « Calques » et déplacez-vous dans les 

Alpes, l’Himalaya ou une chaîne de montagne de votre choix. Constatez la 

modélisation 3D du relief naturel en zoomant sur l’une ou l’autre zone et inclinez 

ensuite votre fenêtre de visualisation dans le plan horizontal via la flèche supérieure 

du bouton  disponible à droite de l’interface, ce qui permet un 

déplacement oblique ou horizontal. 

 Dézoomez et positionnez-vous au-dessus de quelques montagnes. Via l’activation du 

bouton « Lumière du soleil en fonction de l’heure du jour »  dans la partie 

supérieure de l’interface et l’utilisation de la ligne du temps qui apparait, constatez 

l’effet de la position du soleil sur le réflectance des images, effet particulièrement 

visible en zone montagneuse (ombrage).  

 Tapez ensuite « Manhattan, New-York » dans l’onglet « Recherche ». Vous devriez 

arriver à « Central Park ». Déplacez-vous ensuite vers la pointe sud de Manhattan et 

Google Earth 

http://www.google.fr/intl/fr_ALL/earth/versions/
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cochez l’option « Bâtiments 3D » dans le panneau « Calques ». Inclinez à nouveau la 

fenêtre de visualisation dans le plan horizontal et visitez Manhattan en 3D. Déplacez-

vous ensuite vers la « Statue of Liberty ». (Remarque : tout aussi impressionnant, le 

campus d’Arlon est également modélisé en bâtiment 3D). 

 Déplacez-vous ensuite vers Paris et explorez « l’Avenue des Champs Elysées » et 

« l’Arc de triomphe » à l’aide de l’outil « Street view »  disponible à droite de 

l’interface : zoomez d’abord sur l’endroit désiré puis placez le bonhomme orange à 

l’endroit à explorer en mode « Street view ». 

 Découvrez ensuite une vision nocturne de la terre en cochant « Calques > Galerie > 

NASA > Lumières de villes de la Terre ». Dézoomez suffisamment que pour visualiser 

l’ensemble de la terre. 

 La couverture nuageuse (mise à jour toutes les 60 à 90minutes) peut être affichée via 

le panneau « Calques > Météo > Nuages ». 

 Visualisez les changements d’occupation du sol s’étant produit à un endroit de votre 

choix, par exemple pour la Mer d’Aral (à taper dans l’onglet de Recherche), via 

l’activation du bouton « Afficher des images d’archive… »  et l’utilisation de la 

ligne du temps qui apparait. 

Google Earth permet également d’explorer les fonds marins, l’espace, la Lune et Mars. 

Rem : Attention ! Il est possible de récupérer les images de Google Earth : 

 Via une « capture d’écran » (« print screen » en anglais) ou  

 Via le menu de Google Earth « Fichier > Enregistrer > Enregistrer l’image… ».   

Notez qu’il s’agira cependant d’une image « dégradée » correspondant au zoom et à 

l’étendue au moment de la capture, le plus souvent au format « jpg », et non de l’image 

satellite originale utilisée pour réaliser cette représentation 
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4 Pratique de la télédétection spatiale  

Avant toute chose,  

 Téléchargez les données géographiques dont vous allez avoir besoin pour ce TP sur 

votre ordinateur via le lien : 

o https://dox.uliege.be/index.php/s/ualg048wtUCuuxT 

o Dossier « TP_TELEDETECTION.zip » 

Une fois téléchargées,  

 Dézippez le dossier et  

 Placez-le dans votre répertoire de travail à la racine du disque D de votre ordinateur 

(par exemple « D:\TP_TELEDETECTION\»). 

Au cours de ce TP, vous enregistrerez tous vos résultats dans le 

dossier  « D:\TP_TELEDETECTION\DATA\RESULTAT\». 

4.1 Présentation du logiciel de traitement d’images 

numériques ENVI 

ENVI (Environment for Visualizing Images) est un logiciel professionnel de la société 

« EXELIS » (http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx) permettant la 

visualisation, le traitement, l’analyse, et la présentation de nombreux types d’images 

numériques, dont les images satellites.  

En particulier, Envi permet de travailler sur différents types de données (multispectrale, 

hyperspectrale, radar), d’intégrer des données de type matriciel (image) et vectoriel et est 

compatible avec des données de type SIG. Il permet entre autres de contraster les images, 

de les corriger géométriquement, de les classifier, de réaliser des analyses à l’aide de 

données d’élévations, etc. 

ENVI utilise le langage de programmation IDL (Interactive Data Language). 

4.1.1 Les 2 interfaces d’ENVI 

ENVI est composé de 2 interfaces-viewer indépendants : « ENVI » et « ENVI Zoom ». 

https://dox.uliege.be/index.php/s/ualg048wtUCuuxT
http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx
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 ENVI est l’interface principale d’ENVI, vous donnant accès à toutes ses 

fonctionnalités. 

 ENVI Zoom est une version simplifié d’ENVI spécialement conçue pour afficher et 

manipuler plus facilement  et plus efficacement les images satellites (outils de zoom, 

contraste, transparence, brillance, …, projection et rééchantillonnage des données au 

vol,…) 

4.1.2 Ouvrir ENVI 

 Ouvrez ENVI : Démarrer > Tous les programmes > ENVI > ENVI 

 Ouvrez ENVI Zoom : Démarrer > Tous les programmes > ENVI > ENVI Zoom 

4.1.3 Trouver de l’aide dans ENVI 

L’aide d’ENVI est accessible via la barre de menu principale en cliquant sur  

 « Help > Start ENVI help » pour ENVI 

 « Help > Contents… » pour ENVI Zoom  

L’aide est accessible via, notamment, une table des matières, un index et une fenêtre de 

recherche. 

4.2 Exploration d’images satellites dans ENVI Zoom 

Dans cette section, vous allez découvrir les possibilités qu’offre ENVI Zoom pour visualiser des 

données géographiques (image et vecteur) et comprendre de quoi est composée une image 

satellite. 

4.2.1 Ouverture d’un fichier dans ENVIZoom 

 Soit, cliquez sur « File > Open > » puis naviguez jusqu’au fichier d’intérêt 

 Soit, cliquez sur l’icône « Open » (un dossier jaune entre-ouverte) puis naviguez 

jusqu’au fichier d’intérêt 

Ouvrez les fichiers  

 “C:\Program Files\RSI\IDL63\products\envizoom45\data\qb_boulder_msi 

 “C:\Program Files\RSI\IDL63\products\envizoom45\data\qb_boulder_pan 

Les images apparaissent dans le Viewer d’ENVIZoom.  



 16 

4.2.2 Découverte de l’interface d’ENVIZoom et exploration 

d’images 

A l’aide de cette section découvrez les possibilités de visualisation qu’offre ENVIZoom avec 

ces 2 fichiers images. Répondez aux questions posées à la suite de cette section. 

L’interface d’ENVIZoom s’organise de la manière suivante (Figure 5): 

1. Le viewer principal : visualisation des données géographiques qui sont activées dans 
l’onglet « Layer Manager » du panneau latéral. 

2. Les barres de menus et d’outils : accès aux fonctionnalités d’ENVIZoom 

 Barre de menu : 

 File : permet notamment d’ouvrir un fichier, d’accéder au « Data Manager », 
d’accéder à des données sur internet, de sauver un fichier, de démarrer ENVI et de 
modifier vos préférences. 

 Edit : commande la disposition et affichage des couche, via l’onglet “Layer 
Manager” du panneau latéral (undo/redo, remove, order) 

 Display: permet d’activer les options de visualisation “Portal, Blend, Flicker, 
Swipe”. Un « Portal » est une petite fenêtre qui vient s’ajouter dans la fenêtre du 
viewer principal, et qui permet de visualiser simultanément plusieurs couches 
superposées. Le « Portal » se présente comme un bloc de données indépendant 
dans le « Layer Manager » du panneau latéral.   

 Processing : diverses opérations à réaliser sur image 

 Help : l’aide 

 Barres d’outils : 

 Data Manager : liste et donne des informations sur les fichiers précédemment 
ouverts, et permet de les charger dans le « Layer Manager » 

 Do / undo, select, « crosshairs », sauver la vue 

 Outils de déplacement (main, vol) et de zoom (interactif ou automatique) 

 Outils de création et édition vectorielle (désactivés en absence de couche 
vectorielle) 

 Outils de rotation de l’image (interactif ou automatique) 

 Options de visualisation simultanée de différentes couches : “Portal, Blend, Flicker, 
Swipe”. Ces boutons commandent le « Portal » du « Layer Manager » du  panneau 
latéral. (Un « swipe » doublé d’une rotation continue est du plus bel effet !) 

 « Go To » pour zoomer sur des coordonnées (pixel, géographiques ou carte) 

 Brillance, Contraste, Amélioration de contraste (méthode prédéfinie ou 
interactive), « sharpen », transparence 

3. Un panneau latéral :  

 « Overview » : positionne l’étendue de la vue du viewer principal par rapport à 

l’étendue maximale définie par le groupe d’images actives dans le « Layer Manager » 

 « Layer Manager » : se compose de 2 dossiers ou « bloc de données » indépendant : 

o Le dossier « Layers » permet d’activer (« show »), d’organiser (« order »), 

supprimer, zoomer sur les couches. (Similaire à la table des matières d’ArcMap) 
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o Le dossier « Portals »: voir point 2 > Display, ci-dessus 

 « Cursor Value » : donne toute une série d’information sur le pixel « sélectionné » 

pour les différentes couches apparaissant dans le viewer principal : nom de la 

couche, système de coordonnées de la couche, coordonnées du pixel (fichier, carte, 

géographiques), valeur du pixel. 

 
Quelles différences remarquez-vous entre les deux fichiers ? Comment sont-ils structurés ?  

Complétez le tableau ci-dessous. Attention, indiquez clairement les unités. Vous avez le 

choix entre : byte, mètre, nanomètre ou sans unité. 

Caractéristiques \ Images Image « qb_boulder_pan » Image « qb_boulder_msi » 

Dimension matricielle du 
fichier (pixel * pixel * 
nombre de bandes) 

  

Résolution spatiale (taille du 
pixel) 

  

Résolution spectrale   

Taille du fichier   
Figure 4: Caractéristiques des images Quick Bird « Boulder » 

 

 
Figure 5 : Interface d'ENVIZoom 
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4.2.3 Exploration d’images satellites dans ENVI 

Dans cette section, vous allez découvrir les principaux outils qu’ENVI propose pour explorer 

une image satellite :  visualisation et analyse. 

 Ouvrez ENVI : Démarrer > Tous les programmes > ENVI > ENVI 

L’interface d’ENVI s’ouvre. Il s’agit d’une simple barre de menu donnant accès à toutes les 

fonctionnalités d’ENVI (Figure 6). 

 

Figure 6: Interface / barre de menu principale d'ENVI (ENVI 5 Classic) 

4.2.4 Ouverture d’une image dans ENVI 

Dans cette section, vous allez travailler sur une image de type « Landsat Thematic Mapper » 

(Landsat TM). Quelques informations décrivant l’image LANDSAT TM (résolution spectrale et 

spatiale) sont présentées dans la table ci-dessous. 

Nom de la bande Résolution 
spatiale 

Longueur d’onde  

TM Band 1 

30 m 

0.42 – 0.52 µm ~ Bleu ~ Blue 

TM Band 2 0.52 – 0.60 µm ~ Vert ~ Green 

TM Band 3 0.63 – 0.69 µm ~ Rouge ~ Red 

TM Band 4 0.76 – 0.90 µm ~ Proche InfraRouge - PIR  ~ Near InfraRed – NIR 

TM Band 5 1.55 – 1.75 µm ~ Moyen InfraRouge – MIR ~ Middel InfraRed - MIR 

TM Band 6 (non-
disponible) 

120 m 
(rééchantillonné 

à 30 m) 

10.5 – 12.5 µm ~ InfraRouge Thermique – TIR ~ Thermic InfraRed - TIR 

TM Band 7 30 m 2.08 – 2.35 µm ~ Moyen InfraRouge – MIR ~ Middel InfraRed - MIR 

Figure 7 : résolution spectrale et spatiale de l'image Landsat Thematic Mapper 

 

Pour ouvrir cette image : 

 Cliquez sur « File > Open Image File » et naviguez vers le fichier image 

« Can_tmr.img » qui se situe dans le répertoire  “C:\Program 

Files\RSI\IDL63\products\enviz45\data\ can_tmr.img.  

 Cliquez « Ouvrir » 

La fenêtre « Available Band List » (liste de bandes disponibles) (Figure 8) s’ouvre avec le 

fichier « Can_tmr.img ». Cette interface vous permet de sélectionner la/les bande(s) à 

afficher dans une fenêtre de visualisation de votre choix, en « Gray scale » (nuances de gris) 

ou en « RGB Color » (couleurs Red Green Blue). 
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 Cochez l’option « Gray Scale » 

 Sélectionnez  la bande que vous voulez faire apparaitre dans le canal noir et blanc du 

viewer en cliquant sur le nom de la bande. La bande sélectionnée apparait dans 

l’encadré « Selected Band » 

 Cliquez sur « Load Band » pour charger la bande sélectionnée dans une nouvelle 

fenêtre de visualisation. 

La bande de l’image LandsatTM apparait dans une triple fenêtre de visualisation. Ces trois 

fenêtres sont synchronisées spatialement. Elles se composent de : 

 Image viewer : zoom intermédiaire correspondant à l’étendue du carré rouge du 

« Scroll viewer », accès aux fonctionnalités du viewer à travers une barre de menu 

 Scroll viewer : vue d’ensemble de la bande 

 Zoom viewer : zoom avancé sur l’étendue du carré rouge de « l’Image Viewer », 

modifiable via les options + et – dans le coin inférieur gauche de la fenêtre. 

 

 
Figure 8 : Ouverture d’une image dans ENVI : 3 fenêtres de visualisation synchronisées et fenêtre 

« Available Bands List » 

 
Ouvrez à présent une composition colorée de l’image Landsat TM dans un nouveau viewer. 

Dans la fenêtre « Available Band List », 

 Cochez l’option « RGB Color » 
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 Sélectionnez chacune des 3 bandes que vous voulez faire apparaitre dans les 3 

canaux RGB de votre viewer en cliquant sur le nom de la bande. Choisissez R = TM 

Band 4, G = TM Band 7, B = TM Band 3. 

 Cliquez sur l’onglet « Display # 1 » et choisissez « New display » pour créer une 

nouvelle fenêtre de visualisation. 

 Cliquez sur « Load RGB » pour charger les 3 bandes sélectionnées dans cette nouvelle 

fenêtre de visualisation. 

Les 3 bandes sélectionnées de l’image LandsatTM apparaissent dans la nouvelle fenêtre de 

visualisation (Figure 8).  

Prenez le temps d’observer vos images. Que voyez-vous en termes d’occupation du sol ? En 

termes de relief ? 

Il s’agit ici d’une « composition fausses couleurs » car les longueurs d’ondes que vous avez 

attribuées aux 3 canaux RGB, ne correspondent pas à ces 3 couleurs. Les couleurs 

apparaissant à l’écran ne correspondent pas aux couleurs réelles de la scène observée.  

Les compositions fausses couleurs présentent l’avantage de permettre la visualisation de 

données n’appartenant pas au spectre du visible, par exemple, l’InfraRouge, des données de 

type radar, etc. Autrement dit, elle « transforment » la donnée non visible (mais enregistrée 

par un capteur) en une donnée visible. 

Ouvrez maintenant une « composition vrais couleurs » de cette même image dans un 3ème 

viewer.  

 Quelle bande TM choisissez-vous pour les 3 canaux RGB ?  

o Réponse : R = TM3 , G = TM2, B = TM1.  

Cette composition colorée se rapproche plus des couleurs réelles de la scène observée. 

Canaux de visualisation de l’ordinateur 
Longueur d’onde des bandes spectrales d’une composition 

colorée 

Initiale Couleur VRAIE COULEUR FAUSSE COULEUR 

R Red Red [630nm – 700nm] Toutes compositions 
différentes de la composition 

vraie couleur 
G Green Green [490nm – 560nm] 

B Blue Blue [450nm – 490nm] 

4.2.5 Modification du répertoire de travail par défaut 

Lors de l’ouverture d’une image dans ENVI, ENVI présente le répertoire par défaut, par 

exemple « C:\Program Files\RSI\IDL63\products\envi45\data » ou, plus récemment, 

« C:\Program Files\Exelis\ENVI50\classic\data ». Pour modifier le répertoire par défaut,  
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 Cliquez sur « File > Preferences > Default Directories > Data Directory > Choose » et 

naviguez vers le répertoire que vous désirez comme répertoire par défaut 

 Choisissez le répertoire « D:\DATA\ » comme répertoire par défaut pour les données. 

4.2.6 Accès aux informations d’une image 

Plusieurs outils, présentés ci-dessous, sont disponibles pour accéder aux informations 
caractérisant l’image. 

4.2.6.1 Cursor Location / Value… 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Cursor Location / Value » 

La fenêtre « Cursor Location / Value » qui apparait vous renseigne sur la position et la valeur 

du pixel sélectionné. 

4.2.6.2 Pixel Locator… 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Pixel Locator » 

La fenêtre « Pixel Locator » qui apparait, vous renseigne sur la position du pixel se trouvant 

au centre du carré rouge. Cette position est exprimée en Sample = Colonne et Line = Ligne. 

4.2.6.3 Le « Header file » (fichier d’accompagnement). 

Le « Header File » contient toute une série d’information sur le fichier-image. Pour y 

accéder, 

 Cliquez sur « File > Edit ENVI Header » dans la barre de menu principale d’ENVI. 

 Sélectionnez le fichier d’intérêt dans la fenêtre « Edit Header Input File » 

Les informations sur ce fichier apparaissent dans la colonne « File Information ». 

 Remplissez le tableau ci-dessous à l’aide des informations que vous y trouvez. 

 Cliquez « Cancel » car vous ne voulez pas modifier le « Header File ». 
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Caractéristique du fichier-image Landsat TM « Can_tmr.img » 

Dimension de l’image : nombre de pixel colonne * 
nombre de pixel ligne * nombre de bandes 

 

Taille du fichier (Byte)  

Intervalle de longueur d’onde  

Résolution spatiale 30 mètres 

Localisation de l’image – nom du lieu  

4.2.6.4 Quick Stats… 

L’outil « Quick Stats… » calcule des statistiques sur vos images, dont la fréquence de 

distribution des valeurs de pixel dans chaque bande, les valeurs minimum, maximum, 

déviation standard, etc. 

 Cliquez-droit sur une de vos images dans une des fenêtres de visualisation 

 Choisissez « Quick Stats… » 

4.2.6.5 Outil de mesures (distance, superficie) 

L’outil « Measurement Tool » permet de mesurer des distances et des superficies sur une 

image : 

 Cliquez sur « Tool > Measurement Tool » dans la fenêtre de visualisation où se 

trouve l’image pour laquelle vous voulez réaliser une mesure. 

 Dans la fenêtre « Display Measurement Tool » qui apparait, choisissez le viewer 

d’intérêt, cochez la fenêtre d’intérêt, choisissez le type de mesure (lignes (distance), 

polygones (superficie)) et les unités (m, m², etc)  

 Réalisez la mesure dans la fenêtre d’intérêt 

La longueur du / des trait(s) ou la superficie du / des polygones dessinés s’indique(nt) dans la 

fenêtre « Display Measurement Tool ». 
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4.3 Analyse temporelle 

L’analyse temporelle sera illustrée à l’aide de 2 logiciels : « ENVI » dans un premier temps, 

« Windisp » ensuite.  

4.3.1 Analyse  temporelle visuelle (avec ENVI) 

Ouvrez les deux images SPOT VEGETATION NDVI de l’Afrique, disponibles dans le dossier 

« TP_TELEDETECTION\DATA\SPOT VEGEATION AFRIQUE », « decade1_JANVIER_2006 » et 

« decade1_SEPTEMBRE_2006 » dans 2 viewer différents (Figure 9). Elles datent de la 1ère 

décade de janvier 2006 et de la 1ère décade de septembre 2006 respectivement.  

Prenez quelques secondes pour les comparer. 

 

Figure 9 : Analyse temporelle de détection du changement dans ENVI à partir de 2 images NDVI sur 
l’Afrique : à gauche : image de janvier 2006 en noir et blanc ; au centre : image de septembre 2006 
avec la symbologie « GRN-RED-BLU-WHT » ; à droite : image résultante de l’analyse de 
changement (5 classes, méthode de « simple différence » avec normalisation de la gamme des 
valeurs [0-1]. 

 
Pour améliorer la comparaison de ces 2 images par analyse visuelle : 

 Synchronisez spatialement les 2 fenêtres de visualisation et  
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 Utilisez une symbologie adéquate 

Confer sections suivantes ci-dessous.  

4.3.1.1 Synchronisation des fenêtres de visualisation, superposition 

dynamique et transparence 

 Cliquez sur « Tools > Link > Link Displays… » dans la barre de menu d’une des 

fenêtres de visualisation que vous voulez synchroniser. 

 Dans la fenêtre « Link Displays » qui apparait,  

o Changez les « NO » en « Yes » à l’aide des doubles flèches. Cette opération 

synchronise les fenêtres de visualisation sélectionnées. 

o Changez le « Off » en « On ». Cette opération permet une superposition 

dynamique des images des différentes fenêtres de visualisation synchronisées. 

o Indiquez une transparence (opacité en réalité) de 0 %. Cette opération permet de 

rendre la couche supérieure d’une fenêtre de visualisation transparente en 

cliquant dessus. 

o Ne modifiez pas le « Link Size / Position » 

o Cliquez « OK » 

Testez rapidement  la synchronisation de vos fenêtres à partir d’une « Scroll window » et la 

superposition dynamique à partir d’une « Image window ». 

4.3.1.2 Modification de la symbologie 

 Cliquez sur « Tools > Color Mapping > ENVI Color Tables… » dans la barre de menu 

d’une des fenêtres de visualisation dont vous voulez changer la symbologie. 

 Explorez les différents types de symbologie et choisissez une symbologie qui vous 

paraît idéale pour comparer les 2 images, par exemple, la symbologie « GRN-RED-

BLU-WHT » (Figure 9) 

 Répétez ces opérations pour l’autre fenêtre de visualisation. 

Comparez visuellement ces 2 images. Aidez-vous notamment du « Cursor Location / Value ».  

Avec la symbologie « GRN-RED-BLU-WHT », quelle couleur est associée à une faible / 

importante valeur de NDVI ? Que remarquez-vous ? Réfléchissez en termes d’évolution 

spatio-temporelle du NDVI (rem : au Burkina Faso, le mois de janvier fait partie de la saison 

sèche et le mois de septembre de la saison humide). Cette évolution est-elle la même 

partout en Afrique ?  
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NDVI – Normalized Difference Vegetation Index 

Le NDVI est un indice de végétation qui se définit comme la différence normalisée des mesures de 

réflectance spectrale acquises dans les zones de longueurs d’onde « Proche Infra-Rouge » (« PIR ») et 

« Rouge ».  

)(

)(

RougePIR

RougePIR
NDVI




  

 

Sa valeur théorique varie entre -1 et 1.  En pratique, une surface d’eau libre (océan, lac,…) prendra des 

valeurs de NDVI  proches de 0, un sol nu prendra des valeurs de 0.1 à 0.2, alors qu’une végétation 

dense aura des valeurs de 0.5 à 0.8. 

Explication physique du NDVI 

Les plantes vertes absorbent une grande partie des radiations solaires dans une zone de longueurs 

d’onde appelée « PAR » (« Photosynthetically Active Radiation »), dont fait partie la zone du 

« Rouge ». Par contre, le « PIR » est fortement diffusé (non absorbé : transmis et réfléchi) par la 

plante. Par conséquent, une plante verte vive apparait sombre dans le PAR (dont le rouge) car ces 

longueurs d’ondes sont absorbées par la plante (petite valeur de réflectance), et « brillante » dans le 

« PIR » car ces longueurs d’ondes sont réfléchies en partie (grande valeur de réflectance).  

   
 

Le NDVI est directement lié à l’activité photosynthétique des plantes et donc à la capacité 

d’absorbation énergétique de la canopée du couvert végétal. Il agit comme indicateur de la biomasse 

chlorophyllienne des plantes. En termes de réflectance dans le PIR et le Rouge, la neige et les nuages 

se comportent à l’inverse des plantes vertes.   

Figure 10 : Explication du NDVI – Normalisez Difference Vegetation Index 

Une végétation en bonne santé (gauche) 
absorbe la plupart de la lumière visible qui 
l’intercepte et réfléchi une partie importante de 
la lumière PIR.  
 
Une végétation en mauvaise santé ou clairsemée  
(droite) réfléchi plus de lumière visible et moins 
de PIR.  
 
Les chiffres de la figure ci-contre sont 
représentatifs de valeurs réelles mais la réalité 
est bien plus variée. 
 
(Illustration by Robert Simmon, NASA GSFC). 
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4.3.2 Analyse temporelle de « détection du changement » 

(« Change detection analysis ») (avec ENVI) 

L’analyse de détection du changement comprend de nombreuses méthodes dont le but est 

d’identifier, de décrire et de quantifier, les différences entre images d’une même scène 

(même endroit) prises à différents moments ou dans des conditions différentes.  

Avez-vous une idée des situations dans lesquelles ce genre d’analyse peut être utile ?  

Réponse : fonte des glaciers, tsunami, feu de forêt, glissement de terrain, variation 

saisonnière de la végétation. 

Dans le menu « Help \ Start ENVI Help » menu, cherchez dans l’onglet « Index » le « Change 

detection \ Substratcive » et rendez-vous à l’illustration en bas de page.  

A quoi cette situation pourait-elle correspondre ? Qu’en est-il de l’illustration se trouvant 

dans la rubrique « Change detection \ Principal Components » ? 

Vous allez maintenant utiliser l’un des outils les plus simples d’ENVI pour l’analyse de la 

détection du changement : « Compute Difference Map ».  

Pour des informations sur cet outil, utilisez le « Help \ Start ENVI Help \ Contents \ ENVI 

User’s Guide \ Basic Tools \ Change Detection \ Compute Difference Map ». Cet outil 

permet d’analyser le changement entre une paire d’images représentant un « stade initial » 

et un « stade final » (avant et après le changement). L’output résultant de cette opération 

est calculé en soustrayant l’image initiale de l’image finale (FINALE – INITIALE) (Figure ci-

dessous) et  consiste en une image classifiée dont les classes sont définies par des « seuils de 

changement ». Cette « image de changement » nous informe sur l’intensité du changement 

(absence de changement, changement « positifs » ou « négatifs ») et sur sa localisation dans 

l’espace.  

Jetez un œil dans la rubrique «Tips for Successful Analyses » du « change detection 

analysis ».  

Pour analyser le changement en termes de couverture végétale sur l’Afrique entre janvier 

2006 et septembre 2006 (Figure 9), réalisez les opérations suivantes : 

 Allez dans « ENVI main menu \ Basic Tools \ Change Detection \ Compute 

Difference Map” 

 Dans la fenêtre « Select the « Initial State » Image », sélectionnez l’image ante-

changement, dans ce cas-ci, l’image NDVI-Afrique « …\TELEDETECTION\DATA\SPOT 

VEGEATION AFRIQUE\decade1_JANVIER_2006.tif », et cliquez « OK » 
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 Dans la fenêtre « Select the « Final State » Image », sélectionnez l’image post-

changement, dans ce cas-ci, l’image NDVI-Afrique « …\TELEDETECTION\DATA\SPOT 

VEGEATION AFRIQUE\decade1_SEPTEMBRE_2006 », et cliquez « OK » 

 Dans la fenêtre « Compute Difference Map Input Parameters », choisissez, 5 classes.  

Plusieurs méthodes de calcul de changement s’offrent à vous. Vous allez essayer la méthode 

« Simple Difference » avec et sans preprocessing de normalisation : 

 La méthode « Simple difference » réalise une simple différence entre les valeurs de  

Digital Number (« DN ») des deux images. En comparant vos deux images à l’aide du 

« cursor / location value tool », faites-vous une idée sur la gamme de valeurs qui 

ressortira de cette analyse  avec les 2 images NDVI. 

 Le preprocessing « Normalize Data range (0 – 1) », réalise un prétraitement 

consistant en : « (DN – min) / (max – min) » qui réduit la gamme des valeurs de 

chaque image entre 0 et 1. En utilisant cette méthode, quelle gamme de valeurs 

ressortira de l’analyse de changement avec les 2 images NDVI ? 

 Dans la fenêtre « Compute Difference Map Input Parameters », adaptez les valeurs 

seuils (« Treshold ») de vos 5 classes en fonction de la méthode choisie (une 

méthode à la fois). Choisissez d’enregistrer vos images résultats comme fichier dans 

le répertoire « …TELEDETECTION\DATA\SPOT VEGEATION 

AFRIQUE\difference_map\ » avec comme nom : SD_5class_xx_tresh ou 

SD_5class_Norm_xx_tresh. 

 Cliquez « OK » 

Ensuite, chargez vos « images de changement classifiées » dans de nouvelles fenêtres de 

visualisations que vous synchronisez avec les images de base (NDVI) et comparez-les. 

Commentez les résultats obtenus. 

 

Figure 11 : Illustration de l’opération de soustraction algébrique de 2 images satellites (codées sur 
8 bits  28 =  256 valeurs possibles dans la gamme [0-255]) avec des exemples de valeurs de pixels 

(Digital Number (DN) proportionnel au NDVI) 
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4.3.4 Analyse d’une série temporelle d’images NDVI basse 

résolution avec le Time series viewer SPOT-VGT & PROBA-V 

Analyse d’une série temporelle d’images NDVI basse résolution via une application web (temps : 10 

minutes). 

A l’aide du « Time series viewer » développé par le VITO et disponible ici : 

 https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html,  

 

 

 

  

https://proba-v-mep.esa.int/applications/time-series-viewer/app/app.html
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Produits disponibles : 

 NDVI : PROBAV, SPOT-VGT 

 4 CGLS : FAPAR, LAI, FCOVER, Dry Matter Productivity 

 Météo 

 

Explorez les différentes régions du monde proposées ci-dessous et mettez en évidence le lien entre 

l’évolution temporelle des conditions de végétation et des précipitations. 

 Pakistan 

o Double saison de végétation annuelle dans certaines régions 

 Maroc :  

o Nord : saison unique avec amplitude importante et année sèche visible : 
irrégularité interannuelle 

o Sud : faible amplitude 

 Wallonie 

o Saisons larges et amples 
o L’impact de la sécheresse 2018 est-il visible ? 

 Burkina Faso  

o Nord : saisons amples mais étroites 
o Sud : saisons amples et plus large 

 Sud du Bénin 

o FAPAR : qualité des données ?? min max mean ? 
 

Remarquez la possibilité de travailler avec des masques d’occupation du sol (« landcover »). 

De quel(s) capteurs sont issues ces informations ? Quelles sont ses caractéristiques techniques 

principales (résolution spatiale, résolution spectrale et temps de revisite) ? 

Un exemple de graphique est repris ci-dessus.  

4.3.5 Analyse d’une série temporelle d’images basse résolution et 

caractérisation des saisons de végétation avec TIMESAT 

4.3.5.1 Objectifs 

Cette section est consacrée à l’analyse d’une série temporelle d’images satellites basse 

résolution (1 km) de type NDVI en vue d’extraire certains paramètres phénologiques 

caractérisant les saisons de végétation. 
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Les objectifs techniques de l’exercice sont de : 

 Visualiser les images NDVI fournies avec le logiciel (application « TSM_imageview ») 

 Visualiser l’évolution temporelle du NDVI pour différents pixels (application 

« TSM_GU I ») (Figure 16) 

 Comparer les différentes méthodes et paramètres de lissage temporel et 

d’extraction des paramètres phénologiques (application « TSM_GUI ») (Figure 16) 

4.3.5.2 Utilité 

Ce type de manipulation peut être utilisé pour caractériser la dynamique annuelle ou 

pluriannuelle de saisons de végétation et/ou de saisons agricoles à l’échelle régionale ou 

nationale par exemple. Des exemples d’applications sont : l’étude de la désertification, la 

prévision des rendements agricoles. Un exemple, en anglais, de l’utilisation de ce logiciel 

dans un système de prévision des rendements agricoles à l’échelle nationale (Arménie) est 

disponible à titre informatif dans la Présentation Power Point disponible via le lien 

http://orbi.ulg.ac.be/handle/2268/145481.  

4.3.5.3 Présentation du logiciel utilisé : TIMESAT 

Le logiciel utilisé est TIMESAT dont le site web est : 

http://www.nateko.lu.se/TIMESAT/timesat.asp.  

Le principe de base de ce logiciel est simple, comme illustré dans la Figure 12 ci-dessous: 

 Lecture et visualisation d’une série temporelle d’images satellites et production 

d’une courbe traduisant l’évolution temporelle du signal pour chaque pixel (courbe 

noire) 

 Lissage des courbes traduisant l’évolution temporelle du signal pour chaque pixel 

(courbe rouge).  

 Extraction des informations phénologiques à partir des courbes temporelles lissées et 

production d’images de paramètres phénologiques et d’images de NDVI 

temporellement lissées. 

http://orbi.ulg.ac.be/handle/2268/145481.
http://www.nateko.lu.se/TIMESAT/timesat.asp
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Figure 12 : illustration du fonctionnement de TIMESAT : ligne bleue : courbe temporelle bruyante 

du NDVI ; en rouge : courbe temporelle lissée du NDVI ; lettres : paramètres phénologiques 
calculés : (a) beginning of season, (b) end of season, (c) length of season, (d) base value, (e) time of 

middle of season, (f) maximum value, (g) amplitude, (h) small integrated value, (h+i) large 
integrated value. 

4.3.5.4 Téléchargement de TIMESAT 

Ce logiciel est libre et disponible, après enregistrement, via téléchargement sur le site web 

http://www.nateko.lu.se/timesat/timesat.asp?cat=4. Des données exemples et un tutoriel 

(en anglais) sont également disponibles sur ce site web.  

Une fois logué, téléchargez :  

 La version du logiciel adaptée à votre situation. Dans la plupart des cas c’est la 

version “TIMESAT standalone version 3.1.1 for Windows users without Matlab (zip 

archive, 2012-11-22, 181 Mb)” qui doit être téléchargée. Le dossier téléchargé est 

“timesat311_standalone_windows32.zip”. 

4.3.5.5 Installation de TIMESAT 

Remarque: l’installation pause parfois problème avec certains ordinateurs. 

Pour des informations détaillées sur l’installation, référez-vous aux pages pages 36 and 37 

(section 7) du “TIMESAT 3.1 Software Manual” qui est disponible dans le dossier téléchargé. 

Ci-dessous, un résumé des étapes de l’installation: 

 Déziper (décompresser) le dossier téléchargé 

“timesat311_standalone_windows32.zip” dans un répertoire de votre choix, par 

http://www.nateko.lu.se/timesat/timesat.asp?cat=4


 32 

exemple dans  “...\TP_TELEDETECTION\DATA\TIMESAT\”. Le tutoriel 

“timesat3_1_1_SoftwareManual.pdf” est disponible dans le dossier 

“timesat311_standalone_windows32\timesat311\documentation\”. 

 Si Matlab n’est pas installé sur votre ordianteur, il est nécessaire d’installer 

préalablement le petit programme “Matlab Compiler Runtime (MCR) ». Pour les 

utilisateurs Windows, double-cliquez sur le fichier “MCRinstaller.exe » disponible 

dans le répertoire  

“timesat311_standalone_windows32\timesat311\compiled\Win32\”. Vous recevrez 

peut-être le message suivant ".NET Framework is not installed ». Dans ce cas,  

1. Appuyez sur « cancel » et installez “.NET framework” (disponible via une 

recherche sur Google)   

2. Recommencez le processus d’installation. 

 Sinon cliquez sur “OK to continue". Continuez l’installation en cliquant sur “OK” 

plusieurs fois.  

 Le logiciel TIMESAT lui-même n’a pas besoin d’être installé. 

4.3.5.6 Démarrage de TIMESAT 

 Pour démarrer TIMESAT double cliquez sur le fichier “TIMESAT.exe” dans le dossier 

“timesat311_standalone_windows32\timesat311\compiled\Win32\”. Si l’ordinateur 

vous demande « Do you want to execute the file”, cliquez sur “yes”. 

 Après le double clic, une fenêtre DOS (ligne de commande) apparait. Attendez 

quelques secondes et ensuite il vous sera demandé d’indiquer la “TIMESAT 

installation folder”. Naviguez jusqu’au dossier “timesat311” comme montré dans la 

Figure 13 et cliquez “OK”. Cette étape est très importante!! 

 

Figure 13: sélection du dossier d’installation de TIMESAT au démarrage de  TIMESAT. 
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 Ensuite la fenêtre principale de TIMESAT, le “Timesat menu system”, s’ouvrira (Figure 

14). 

 

Figure 14: principale interface de TIMESAT 
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 Dans la fenêtre “Timesat menu system” vous devez indiquer le répertoire de travail 

(« working directory ») (Figure 15) (p. 37 et p. 43 du manuel “TIMESAT 3.1 Software 

Manual”). Cette étape est très importante. Le répertoire de travail est le répertoire 

dans lequel les résultats des calculs de TIMESAT seront enregistrés.  

 Allez dans “TIMESAT menu system  > File > Preferences” et naviguez jusqu’au 

répertoire de travail, dans ce cas: “…\ 

TIMESAT311\timesat311_standalone_windows32\timesat311\run\.  

 

Figure 15: menu pour définir le répertoire de travail adéquat au démarrage de TIMESAT. 

4.3.5.7 Utilisation de TIMESAT 

Utilisation de TIMESAT pour : 

 Visualiser les images NDVI fournies avec le logiciel (application « TSM_imageview ») 

 Visualiser l’évolution temporelle du NDVI pour différents pixels (application « 

TSM_GU I ») (Figure 27) 

 Comparer les différentes méthodes et paramètres de lissage temporel et 

d’extraction des paramètres phénologiques (application « TSM_GUI ») () 

Ceci peut se faire avec les données fournies dans le dossier 

« …\TIMESAT311\timesat311_standalone_windows32\timesat311\data\wa\ » 

 Le fichier liste « ndvilistwa.txt » 

 Les 108 images NDVI allant de « wa_nd00011.img » à « wa_nd99123.img » couvrant 

une période de 3 ans (36 images par an, 1 image par décade). Ces image sont de 

dimensions = 200 lignes * 200 colonnes et  de format de type « 8-bit unsigned ». 

En cas de problème référez-vous au manuel de TIMESAT à partir de la page 40 à la section « 

9 Getting started with TIMESAT – a quick tutorial ». 
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Figure 16 : interface « TSM_GUI » de TIMESAT : visualisation de l’évolution temporelle du signal 

NDVI pour 1 pixel, de son lissage, paramètres et extraction des paramètres phénologiques. 
 

4.4 Création d’un indice NDVI à partir d’une image 

Landsat TM 

Envi propose un outil pratique pour créer un indice NDVI à partir de bandes de réflectance 

dans le rouge et le proche-infrarouge : « NDVI Calculation Parameters ». 

 Cliquez sur « Transform > NDVI » dans la barre de menu principale d’ENVI. 

 Sélectionnez l’image Landsat TM « can_tmr.img » dans la fenêtre « NDVI Calculation 

Input File » qui apparait. 

 Cliquez « OK » 

 Choisissez « Landsat TM »  comme « Input File Type » dans le menu déroulant 

 Indiquez le numéro des bandes qui correspondent aux longueurs d’onde Rouge et 

Proche Infra Rouge, bandes numéro 3 et 4 respectivement 

 Sauvez votre résultat dans un fichier (« File ») dans le répertoire « RESULTAT » 

 Choisissez « Floating Point » comme « Output Data Type » 

 Cliquez « OK » 

Votre bande NDVI « NDVI_calcul » apparait dans la fenêtre « Available Bands List ». 
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 Chargez-la dans une nouvelle fenêtre de visualisation. 

Comparez cette image avec la composition colorée vraie couleur. Que constatez-vous ? 

Comment apparaissent neige,  végétation et sol nu ? Les valeurs de NDVI sont accessibles via 

l’outil « Cursor Location / Value ». Donnez une valeur de NDVI moyenne des 3 types 

d’occupation du sol sus-mentionnées. 

Une autre possibilité pour créer un indice NDVI, ou toute autre combinaison de bandes, est 

donnée par l’outil « Band Math ». 

 Cliquez sur « Basic Tools > Band Math », pour y accéder. 

Ensuite il vous suffira de taper une expression du type « b4 – b3 » dans la fenêtre « Enter an 

expression », de cliquer « Add to List », de la sélectionner, de définir par sélection les bandes 

correspondant à b4 et b3 et de choisir un « output file ». 

Fermez toutes les fenêtres de visualisation. 
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4.5 Visualisation 3D d’un « Modèle Numérique de 

Terrain » (MNT) ou « Digital Elevation Model » 

(DEM) 

Dans cette section, vous travailler avec un Modèle Numérique de Terrain (MNT) du monde. 
 
Ouvrez le MNT du monde dans un nouveau viewer : 

 Cliquez sur « File > Open Image File… » dans la fenêtre « Available Band List » 

 Naviguez jusqu’au répertoire où se situe votre MNT, dans ce cas-ci, “C:\Program 

Files\RSI\IDL63\products\envi45\data\worl_dem » 

 Sélectionnez-le et cliquez « Open » 

Le fichier « world_dem » s’ajoute dans la fenêtre « Available Band List ». Il est composé de 2 

bandes correspondant aux élévations minimale et maximale. Accédez aux informations 

disponibles sur ce fichier dans la rubrique « Map Info » de cette couche. 

 Chargez la bande d’élévation maximale dans un nouveau viewer. 

Pour une meilleure visualisation, changez la symbologie noir et blanc actuelle en un 

symbologie colorée : 

 Cliquez sur « Tools > Color Mapping > ENVI Color Tables… » dans la barre de menu 

de la fenêtre de visualisation. 

 Explorez les différents types de symbologie et choisissez une symbologie qui vous 

paraît adéquate. Par exemple, la symbologie « Eos A » 

Visualiser l’entièreté du monde en 3D sans exagération verticale (multiplication de l’altitude 

par un facteur > 1) ne serait pas très intéressant car la variation verticale de la surface 

terrestre (élévation entre 0 et 8 km) est insignifiante face à l’étendue horizontale du monde 

(circonférence de la terre d’environ 40 000 km). De plus, si vous vous intéressez à une région 

particulière du monde, par exemple, l’Himalaya, vous choisirez de réaliser un « Spatial 

Subset » (sélection d’une région particulière) centré sur l’Himalaya. 

 Cliquez sur « Tools > 3D SurfaceView… » dans la barre de menu de la fenêtre de 

visualisation dans laquelle se situe votre MNT 

 Sélectionnez la bande « Maximum Elevation » dans la fenêtre « Associated DEM 

Input File ».  

Les informations sur cette bande apparaissent dans la colonne « Band Information » de cette 

fenêtre. 
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 Cliquez « OK » 

La fenêtre « 3D SurfaceView Input Parameters » apparait.  

 Indiquez une exagération verticale de 600 si vous voulez visualiser la totalité du 

monde en 3D, ou une exagération de 100 si vous vous  concentrez sur l’Himalaya. 

 Réalisez éventuellement un « Spatial Subset » (si vous vous concentrez sur une 

région particulière) à l’aide de l’option « Image » qui vous permet de sélectionner 

directement la région d’intérêt sur la carte du monde. Laissez la valeur par défaut de  

400 colonnes * 400 lignes mais ajustez la position du « subset » sur l’Hymalaya 

 Cliquez « OK » 2 fois. 

Votre surface 3D apparait après quelques secondes dans la fenêtre « 3D SurfaceView (Vert 

Exag : 600.0 (ou 100)) ». Explorez votre MNT. Eventuellement, créez un nouvel MNT pour 

une autre région du monde avec une autre symbologie. 

 
Figure 17: Vue 3D du monde obtenue à l’aide de l’outil 3D « SurfaceView » d’ENVI. 

 
ENVI permet également de visualiser des images satellites en 3D pour peu que vous 

possédiez une image et un DEM géoréférencés et couvrant la même zone (la partie 

commune à l’image et au DEM sera représentée en 3D). Ceci est réalisé dans la section 

« 4.7.2.2 Observation d’une image en 3D », page 43. 
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4.6 Correction géométrique 

Les images satellites, telles qu’enregistrées par les capteurs des satellites, présentent 

souvent des erreurs dites « géométriques ». Deux  grands types d’erreurs sont à distinguer : 

 Erreurs systématiques (liées au système d’enregistrement de l’image, dues à la 

rotation de la terre, à l’angle de balayage…). Ces erreurs, à condition de posséder 

suffisamment d’informations sur la position du capteur, angle de prise de vue, etc,   

peuvent être corrigées par « Orthorectification ». 

 Erreurs accidentelles (causes fortuites, mouvements incontrôlés du satellite par 

rapport à sa ligne orbitale et à la verticale du lieu, variation d’altitude). Ces erreurs ne 

sont pas connues à priori, et ne peuvent donc être corrigées par orthorectification. La 

correction appliquée est de type « géoréférencement simple » et utilise des points de 

positionnement (points de calage) connus facilement retrouvables sur l’image à 

corriger. 

Ces erreurs géométriques peuvent avoir comme conséquences des erreurs de 

positionnement de l’image mais aussi des erreurs dans l’estimation des superficies dues 

aux déformations de l’image.  

Dans le cadre de ce TP, vous réaliserez une correction géométrique par géoréférencement 

simple. 

 Ouvrez les images suivantes dans 2 nouveaux viewer 

o  « SPOT10mNamurBAND1.img » (Viewer 1) 

o « SPOT10mNamurNONGEO.tif » (Viewer 2) 

L’image « SPOT10mNamurNONGEO.tif » est identique à l’image « SPOT10mNamur.tif », si ce 

n’est qu’elle présente une déformation géométrique. Il s’agit d’un décalage spatial non 

connu précisément. Vous allez donc devoir la géoréférencer. ENVI propose plusieurs 

méthodes pour réaliser ce type d’opération en fonction du type de donnée utilisée pour le 

positionnement de référence (une image, une carte, des points de contrôle issus de GPS,…). 

Dans ce cas-ci, vous allez géoréférencer votre image « SPOT10mNamurNONGEO.tif » à l’aide 

de l’image « SPOT10mNamurBAND1.img » qui elle est correctement géoréférencée. 

Constater l’erreur de positionnement de votre image « SPOT10mNamurNONGEO.tif » : 

 Cliquez sur « Tools > Link > Link Display… » dans la barre de menu d’une fenêtre de 

visualisation et synchronisez vos 2 fenêtres de visualisation en activant la 

superposition dynamique et choisissez une transparence de 0 %. 
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 Zoomez sur un endroit très caractéristique de votre image, par exemple, la jonction 

entre la Sambre et la Meuse dans le centre de Namur. Arrangez-vous pour avoir cette 

jonction dans le coin inférieur droit de votre viewer 2. 

 Cliquez sur le viewer image 2. 

L’image de référence (viewer 1) devrait apparaitre dans le viewer 2 lorsque vous cliquez 

dessus. Constatez le décalage spatial entre ces 2 images.  

 Cliquez sur « Tools > Link > Unlink Display » pour ne plus synchroniser les viewer, ce 

qui serait gênant pour la géoréférenciation. 

Pour géoréférencer votre image « SPOT10mNamurNONGEO.tif », 

 Cliquez sur « Map > Registration > Select GCPs : Image to Image » 

 Indiquez le display 1 comme le display contenant l’image de référence (« Base 

image ») et le display 2 comme le display contenant l’image à géoréférencer. 

 Cliquez « OK » 

Une fenêtre « Ground Control Point Selection » apparait. C’est à l’aide de cette interface 

que vous allez géoréférencer l’image en créant des points de contrôle au sol ou « Ground 

Control Point » (« GCP »).  

 Cliquez sur « Show List » pour afficher la liste de GCP existant, et ouvrez cette 

fenêtre complètement (vers la gauche) 

Pour l’instant elle est vide.  

 Sélectionnez un endroit très clairement visible et identifiable (au pixel près !) dans 

l’image de référence (viewer 1) (par exemple la pointe de terre à la jonction de la 

Sambre et de la Meuse) 

 Sélectionnez le pixel correspondant dans l’image à corriger 

 Cliquez sur « Add Point » pour enregistrer ce premier GCP. Il s’ajoute dans votre 

table de GCP. 

Lors de la saisie de GCP, ENVI calcul l’erreur quadratique moyenne (« Root Mean Square 

Error » ou « RMSE ») à partir de 5 GCP (à droite dans la table). En principe, cette erreur doit 

être inférieure à la taille d’un pixel de l’image à géoréférencer, ici 10 mètres. Dans votre cas, 

pour une question de rapidité, tolérez un RMSE de 20 mètres. Supprimez les points qui 

présentent un RMSE trop important. Gardez un quinzaine de points GCP au final. 

 Choisissez dans ce cas-ci une correction géométrique au premier degré. 

Lorsque vous avez suffisamment de points et que le RMSE est suffisamment petit, 

 Cliquez sur « Option > Warp File (as Image to Map)… » dans la fenêtre « Ground 

Control Point Selection » 
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 Sélectionnez l’image  « SPOT10mNamurNONGEO.tif » et cliquez « OK » dans la 

fenêtre « Input Warp Image » 

 Dans la fenêtre « Registration Parameters », choisissez une transformation 

polynomiale de degré 1, avec un ré-échantillonnage du plus proche voisin, et 

enregistrez votre fichier output dans le dossier « RESULTAT »  

 Cliquez « OK » 

Votre image géoréférencée apparait dans la fenêtre « Available Bands List » 

 Analysez votre résultat par superposition dynamique avec l’image de référence dans 

un nouveau viewer. 
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4.7 Réalisation d’une carte d’occupation du sol par 

classification supervisée d’une image SPOT 

multispectrale 

Dans cette section, vous allez réaliser une carte d’occupation du sol par classification 

supervisée d’une image satellite SPOT  de la région de Namur. L’image SPOT dont vous allez 

avoir besoin se situe dans le répertoire «...\DATA\SPOT NAMUR\». 

Les grandes étapes à suivre sont : 

 Observation de l’image en 2D et 3D 

 Classification supervisée de l’image (et analyse de la séparabilité spectrale des 

classes) 

 Validation des résultats de la classification 

 Production de la carte d’occupation du sol dérivée de la classification (dans ENVI, 

QGIS ou ArcGIS) 

 

 

  

 Une vidéo-tutoriel de 18 minutes explique de manière résumée comment procéder  

o https://www.youtube.com/watch?v=uPxwmBGmH9o&list=UUEs-zMTorbCxWOV-

E5ivJIg 

o  ! Utilisez le chapitrage disponible sous la vidéo pour accéder facilement à la 

partie de la vidéo qui vous intéresse ! 

  

https://www.youtube.com/watch?v=uPxwmBGmH9o&list=UUEs-zMTorbCxWOV-E5ivJIg
https://www.youtube.com/watch?v=uPxwmBGmH9o&list=UUEs-zMTorbCxWOV-E5ivJIg
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4.7.2 Observation d’une image 

4.7.2.1 Observation d’une image en 2D 

Ouvrez l’image « SPOT10mNamur.tif » dans un nouveau viewer en « RGB » en sélectionnant 

les bandes de votre choix. Cette image est issue du capteur SPOT4 ou SPOT5. Ces principales 

caractéristiques sont reprises dans le tableau ci-dessous. 

Nom de la bande Longueur d’onde Spectre électromagnétique Résolution spatiale 

B1 0.50 - 0.59 µm Vert et Jaune 10 mètres 

B2 0.61 - 0.68 µm Rouge 10 mètres 

B3 0.78 - 0.89 µm Proche InfaRouge (PIR) 10 mètres 

B4 1.58 - 1.75 µm Moyen InfraRouge (MIR) 10 mètres 
Figure 18: caractéristiques de l’image SPOT 

4.7.2.2 Observation d’une image en 3D à l’aide d’un MNT (DEM) 

Pour visualiser l’image en 3D (Figure 19: Visualisation 3D de la ville de Namur (centre-ville, 

Meuse, citadelle, campagne alentour) à l’aide d’une image SPOT et d’un MNT (ASTER 

GDEM)), un MNT correspondant à la zone de l’image est nécessaire. La partie commune à 

l’image et au MNT sera représentée en 3D. Le MNT nécessaire à cet exercice est fourni dans 

le dossier « DATA\ASTGTM_N50E004\ASTGTM_N50E004_dem.tif ». 

 Ouvrez l’image « SPOT10mNamur.tif » dans une nouvelle fenêtre de visualisation 

(confer ci-dessus) 

 Utilisez le menu « 3D SurfaceView » de la fenêtre de visualisation dans laquelle 

l’image est ouverte (confer section 4.5) et utilisez le MNT 

« ASTGTM_N50E004_dem.tif ».  

 Adapter les paramètres de visualisation, avec par exemple : 

o Une exagération verticale de 5 

o Un « spatial subset » centré sur le centre-ville de Namur et la citadelle 

Remarquez que ce type de représentation, combinant les informations spectrales et 

l’altitude, aide à la compréhension et à l’analyse de l’organisation de l’espace, et facilitera en 

particulier votre photo-interprétation. 
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Figure 19: Visualisation 3D de la ville de Namur (centre-ville, Meuse, citadelle, campagne alentour) 

à l’aide d’une image SPOT et d’un MNT (ASTER GDEM) 

 

4.7.2.3 Identification des classes d’occupation du sol 

Analyser visuellement votre image et repérez les grands types d’occupation du sol : 

 Centres urbains (ville et village, bâtiments, gare, …) 

 Routes (autoroute, route, rail) 

 Zones boisées (forêt, bois,…) 

 Terres agricoles (champ cultivé et champ nu) 

 Cours d’eau (fleuves, canaux,…) 

 Carrière 

 … 

Décidez des classes que vous essayerez de retrouver par classification automatique de 

l’image (entre 5 et 8 classes). Pour cet exercice, et pour simplifier les choses, vous pouvez 

travailler avec les 7 classes suivantes seulement : 
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Classe Description  

BATIT Routes, maisons, etc 

EAU Fleuve, étang, large rivière 

SOL NU TERRE Sol nu (terre) dont principalement des parcelles agricoles avec sol nu 

VEGETATION CULTURE Parcelles agricoles avec végétation 

FORET FEUILLUE Arbre et massif forestier de type feuillu 

FORET CONIFERE Arbre et massif forestier de type conifère 

NO DATA Zones sans donnée en dehors de l’image 

4.7.2.4 Utilisation de données complémentaires pour l’analyse visuelle d’une 

image 

La photo-interprétation (reconnaissance des différentes occupations du sol par analyse 

visuelle) d’une image est parfois difficile : 

 Soit parce que l’image ne présente pas une qualité suffisante (résolution spatiale et 

spectrale adéquate), 

 Soit à cause d’un manque d’expérience du photo-interpréteur ou d’un manque de 

connaissance de la zone.  

La photo-interprétation peut être facilitée grâce à l’utilisation de données complémentaires 

sur la zone étudiée, par exemple : 

 Analyse visuelle de la zone dans Google Earth Pro. Google Earth Pro dispose d’image 

à très haute résolution spatiale pour une partie sans cesse grandissante de la 

planète. Attention toutefois à garder à l’esprit que les images de Google Earth Pro ne 

datent probablement pas de la même période que celle qui fait l’objet de votre 

étude. Par exemple, la reconnaissance des types de forêt au Sud de Namur se fait 

facilement dans Google Earth (feuillus versus résineux). 

 Cartes topographiques 

 Une enquête de terrain avec relevé GPS 

 Divers documents donnant des informations sur l’occupation du sol de la zone. 

4.7.2.5 Outil « Animation » 

L’outil « Animation » permet d’afficher automatiquement, successivement et à une certaine 

vitesse les différentes bandes d’un fichier-image. 

 Cliquez sur « Tools > Animation… » 

 Sélectionnez les 4 bandes de l’image SPOT 

 Cliquez « OK » 
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Une fenêtre animée apparait. Modifiez en la vitesse si nécessaire. Qu’est-ce que cet outil 

permet de mettre clairement en évidence ? 

 Réponse : la forte différence de valeur de réflectance selon les bandes pour une 

même occupation du sol. 

4.7.2.6 Amélioration de contraste 

L’amélioration de contraste  consiste en une transformation virtuelle des données afin 

d’utiliser toute la gamme d’intensité de couleur disponible pour visualiser les données à 

l’écran. Cette amélioration ne modifie donc pas vos données sources (la valeur des pixels). 

Elle ne fait qu’attribuer différemment la palette de couleur disponible à votre image afin de 

faire ressortir certains éléments plus clairement. 

L’amélioration de contraste proposée par ENVI par défaut est de type linéaire et se base sur 

la fenêtre « Scroll » reprenant l’ensemble de l’image. 

Tentez de trouver une amélioration de contraste qui facilite l’interprétation visuelle de 

l’image : 

 Cliquez sur « Enhance » dans la barre de menu du viewer. 

Vous avez le choix entre différentes améliorations de contraste prédéfinies, à appliquer sur 

chacun des 3 types de viewer (Image, Scroll et Zoom). Vous pouvez également réaliser une 

amélioration de contraste manuellement de manière interactive (« Interactive Stretching »). 

Des filtres sont également disponibles (« Filter »).  

4.7.3 Classification d’une image 

Il existe différents types de méthodes de classifications :  

 Supervisée : l’opérateur défini lui-même les classes à produire (nombre, 

caractéristique spectrale,…)  

 Non-supervisée : le logiciel défini lui-même les classes 

 

 Par pixel : chaque pixel est classifié individuellement et indépendamment des pixels 

voisins 

 Par objet : l’image est d’abord découpée en objet (1 objet = 1 ensemble de pixels 

voisins spectralement homogène) au cours d’une étape de « segmentation ». 

Ensuite, les caractéristiques de ces objets sont utilisées pour les classifier. 

4.7.3.1 Classification non-supervisée 
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Réalisez 2 classifications non-supervisées de votre image. Une classification « Iso-Data » et 

une classification « K-means ». 

 Cliquez sur « Classification > Unsupervised > Iso-Data et puis K-means » 

 Sélectionnez votre image géoréférencée comme image à classifier 

 Laissez la plupart des paramètres par défaut.  

 Enregistrez le résultat dans votre dossier « Résultat » avec comme nom, le nom de la 

méthode utilisée. 

Visualisez les 2 classifications dans 2 nouveaux viewer et commentez-les (nombre de classes, 

type d’occupation du sol reconnus, mélangés, etc). 

4.7.3.2 Classification supervisée 

Réalisez une classification supervisée d’une image satellite sous-entend que vous possédez 

une très bonne connaissance de l’occupation du sol réelle de la zone de l’image à l’époque 

où l’image a été prise. Cette connaissance peut venir de plusieurs sources comme expliqué 

ci-dessus à la section 4.7.2.4 « Utilisation de données complémentaires pour l’analyse 

visuelle d’une image ».  

Dans ce cas-ci, comme il n’y a pas eu d’enquête de terrain, vous procéderez par photo-

interprétation en vous aidant éventuellement de Google Earth pour les classes les plus 

difficilement reconnaissables.   

4.7.3.2.1 Définition de la légende de la future carte d’occupation du sol 

A partir de l’examen de la composition colorée de la zone à classifier (également avec 

l’amélioration de contraste), et de votre connaissance de la région étudiée, définissez la 

légende de la carte, c’est-à-dire les classes d’occupation du sol que vous désirez voir 

apparaitre dans la carte d’occupation du sol qui sera produite. 

4.7.3.2.2 Définition du nombre de classes spectrales 

A partir de l’examen de la composition colorée de la zone à classifier (également avec 

l’amélioration de contraste), identifiez également combien de signatures spectrales 

différentes correspondent à chaque classe de la légende identifiées à la section précédente. 

En effet, une occupation du sol telle que « culture » peut présenter différentes signatures 

spectrales au moment de l’enregistrement de l’image, selon l’espèce cultivée et son stade 

végétatif (Figure 20). Il s’agit donc de définir autant de classes spectrales qu’il existe de 



 48 

situations spectralement bien différentes pour chaque occupation du sol. L’algorithme de 

classification pourra ainsi traiter chaque signature spectrale de manière indépendante.  

Classe de la 
légende de la carte 

Classes spectrales correspondantes utilisée pendant le processus de 
classification supervisée 

Forêt Forêt de feuillu (ex : vert clair) 
Forêt de résineux (ex : vert foncé) 

Zones agricoles Parcelles agricoles présentant un sol nu (ex : brun) 
Parcelles agricoles présentant une culture x (ex : colza en fleur, jaune) 
Parcelles agricoles présentant une culture y (ex : prairie, vert) 
… 

Zones construites Routes (ex : gris) 
Toits d’ardoise (ex : noir) 
Toits de tuiles (ex : rouge) 

… … 

Figure 20 : Exemple simplifié de relation entre les classes d’occupation du sol représentées 
sur une carte et les classes spectrales correspondantes ayant été utilisées lors du processus 
de classification supervisée 
 

L’examen des signatures spectrales de chaque classe spectrale peut se faire dans ENVI à 

l’aide des aires d’entrainement (confer ci-dessous la section 4.7.3.2.3) et de l’analyse de leur 

séparabilité (confer section 4.9 « Séparabilité spectrale des classes d’occupation du sol sur 

une image »). 

Les différentes classes spectrales appartenant à un même taxon d’occupation du sol 

pourront être fusionnées après la classification pour une meilleure représentation 

cartographique (confer ci-dessous la section 4.7.5 « Post-traitement d’une image classifiée 

pour améliorer le rendu visuel »). 

Dans ce cas-ci, pour vous faciliter la tâche, créez 7 classes maximum (confer tableau ci-

dessus). 

4.7.3.2.3 Sélection des aires d’entrainement ou « ROI – Region Of Interest» 

pour chaque classe 

Il s’agit de sélectionner un minimum de 30 pixels spectralement représentatif  de chaque 

signature spectrale identifiée précédemment. Ces échantillons, ou « aires d’entrainement » 

serviront à la « CALIBRATION » de votre classification. Elles sont définies à l’écran par la 

numérisation d’un ou plusieurs polygones pour chaque classe spectrale. Sur base des 

polygones ainsi définis, l’extraction automatique des valeurs de pixels contenues à l’intérieur 

des polygones et le calcul de leur moyenne et écart-type produiront la signature spectrale de 

chaque classe à partir des 4 canaux de l’image SPOT. 
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Les aires d’entrainement doivent être représentatives de chaque classe spectrale 

considérée. Voici quelques conseils pour la sélection des aires d’entrainement : 

 Il est souvent préférable que ces aires d’entrainement soient bien réparties sur toute 

l’image. En effet, ceci permettra de prendre en compte : 

o Les éventuels gradients de luminosité entre les différentes zones de l’image 

(conditions atmosphériques, relief/exposition,…) 

o Une légère différence spectrale entre une même classe d’occupation du sol 

dans des régions différentes (gradient ou classes pédologiques, variation des 

espèces végétales ou de leur état de développement, etc). 

o … 

 Un minimum de 30 pixels par classe spectrale et un nombre suffisant d’aires 

d’entrainement pour qu’elles soient représentatives de la classe spectrale 

considérée. Le nombre d’aires d’entrainement nécessaire dépendra donc de la 

complexité spectrale de chaque classe et de la complexité de l’image. Par exemple, 

une image ne comprenant comme occupation du sol que  le désert et la mer sera 

extrêmement facile à classifier et cela pourra se faire avec peu d’aires 

d’entrainement (une seule aire d’entrainement par clase suffira probablement). A 

l’inverse une image présentant un mélange de végétation naturelle et cultivée de 

différent types et à différents stades de développement sera plus difficile à classifier 

car les classes d’occupation du sol sont plus nombreuses, elles se ressemblent plus 

entre-elles et elles présentent peut-être chacune une plus grande hétérogénéité 

spectrale. Dans ce cas il sera nécessaire d’utiliser plus d’aires d’entrainement par 

classe afin que les aires d’entrainement soient bien représentatives de toutes les 

légères variations d’une classe spectrale donnée et permettent de différencier au 

mieux les classes les unes des autres. 

 La courbe de la distribution du nombre de pixels en fonction de leur réflectance 

(pour une bande spectrale donnée) doit être uni-modale (ou s’en rapprocher). Si elle 

est multimodale, ceci constitue une indication que ces aires correspondent à 

plusieurs classes spectralement distinguables et qu’il faut donc les séparer en autant 

de classes qu’il n’y a de mode dans la courbe. 

 Ne considérer que des « pixels purs », c’est-à-dire des pixels correspondant 

uniquement à la classe d’occupation du sol visée et non des pixels couvrant plusieurs 

classes d’occupation du sol  (« mixel » : pixel mixte). Par exemple, pour des zones 
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d’entrainement d’un fleuve, ne pas considérer des pixels se trouvant proche de la 

berge car leur réflectance risque d’être influencée par la berge. 

Faites attention à faire apparaitre la mention « cal » dans le nom de ces classes qui seront 

utilisées à des fins de calibration (par exemple : « forêt_cal »), et ce afin de facilement faire la 

distinction entre vos classes de calibration et de validation lors de la création de la matrice de 

confusion (voir plus loin). 

4.7.3.2.4 Création de ROIs dans ENVI 

La définition des aires d’entrainement dans ENVI se fait via la création de « ROI » (« Region 

Of Interest ». Pour créer des ROIs : 

 Cliquez-droit sur l’image à classifier lorsqu’elle est affichée dans un viewer 

 Choisissez « ROI Tool… » 

La fenêtre « ROI Tool » apparait (Figure 21). C’est l’assistant de création des ROIs. 

 Dans cette fenêtre, choisissez la fenêtre « Image » comme zone de création des ROIs. 

 Nommez votre première région « foret » par exemple, et choisissez une couleur vert 

foncé 

 Dans la fenêtre Image, à l’aide de clic-gauche de la souris, créez un polygone autour 

d’une première zone représentative de la forêt. Pour terminer le polygone, faites 2 

clic-droit. 

 Répétez cette opération pour un certain nombre de polygones de cette classe jusqu’à 

ce que vous jugiez avoir un nombre représentatif de pixels « forêt » enregistrés 

comme ROI. 

 Pour ajouter une nouvelle classe, cliquez sur « NewRegion » 
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Figure 21 : Classification supervisée d’une image dans ENVI : à gauche : image satellite et aires 
d’entrainement (« ROIs ») (polygones verts) ; au centre : image classifiée avec une symbologie 
adéquate; à droite : table des aires d’entrainement (« ROI Tool ») avec des aires pour chaque 
classe d’occupation du sol en calibration et validation.  

 
Construisez petit à petit vos ROI pour vos 5 classes d’occupation du sol. Une fois toutes vos 

ROI réalisées, sauvez-les dans un fichier 

 Cliquez sur « File > Save ROIs… » 

 Sélectionnez toute vos ROI 

 Enregistrez les dans un fichier « ROI.roi » dans votre dossier résultat. 

Répétez toutes ces opérations pour créer un nouveau fichier de ROI qui servira pour la 

VALIDATION de votre classification. Faites attention à faire apparaitre la mention « val » 

dans le nom de ces classes qui seront utilisées à des fins de validation (par exemple : 

« forêt_val »). Attention, cette opération ne peut être réalisée que parce que vous êtes 

confient à 100 % dans votre photo-interprétation. Nommez-le « ROI_VAL.roi » dans votre 

dossier résultat. 

 Fermez cet assistant de création lorsque vos deux fichiers ROI ont été créés.
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4.7.3.2.5 Classification d’une image (classification supervisée) 

Pour classifier l’image de manière supervisée : 

 Cliquez sur « Classification > Supervised > Maximum Likelihood » dans la barre de 

menu principale d’ENVI. 

 Sélectionnez l’image à classifier (votre image géoréférencée) 

 Dans l’onglet « Open > ROI Files… », Sélectionnez votre fichier ROI de calibration 

« Roi.roi ». 

 Cliquez « OK » 

 Dans la fenêtre « Maximum Likelihood Parameters »,  sélectionnez toutes les 

classes, enregistrez votre classification comme fichier « CLASSIF_SUP » dans votre 

dossier « Résultats » et désactivez l’ »Output Rule Images » 

 Cliquez « OK » 

La classification se réalise. L’algorithme de classification selon le maximum de vraisemblance 

(« Maximum Likelihood ») est appliqué à tous les pixels de l’image sur base des paramètres 

statistiques décrivant chaque signature spectrale obtenue. La comparaison entre les valeurs 

de chaque pixel et les signatures spectrales des différentes classes déterminera la 

probabilité d’appartenance du pixel à chacune des classes. La classe présentant la 

probabilité maximum sera attribuée au pixel considéré. Le résultat apparait dans la fenêtre 

« Available Band List ». 

 Visualisez votre résultat dans un nouveau viewer. 

 Comparez ce résultat avec l’image de base par lien dynamique synchronisé des 

viewer (Figure 21). 

Cette comparaison vous permet d’identifier les défauts éventuels de votre classification et 

donc de l’améliorer. 

4.7.4 Validation de la classification supervisée : matrice de 

confusion 

4.7.4.1 Sélection des aires de validation (ROI de validation) 

Idéalement la définition des aires qui serviront à la validation d’une classification 

supervisée doit se faire de manière aléatoire afin de ne pas tronquer la validation. En effet, 

l’opérateur aura naturellement  tendance à choisir pour la validation des zones qu’il peut 

facilement photo-interpréter et qui sont probablement plus facilement classifiables que 

d’autres. Ceci  aura pour conséquence de fausser les résultats de la validation en présentant 
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une précision de classification surestimée. Un outil comme la fonction « Points 

aléatoires… » du logiciel QGIS peut être utilisé pour identifier les endroits à utiliser pour la 

validation.  

S’il existe des zones pour lesquelles la classe d’occupation du sol réelle n’est pas connue 

(photo-interprétation trop difficile, pas d’information venant du terrain, etc) il devient 

impossible d’en réaliser la validation. A l’opérateur alors d’estimer si ces zones sont 

négligeables (par exemple parce qu’elles couvrent un très faible pourcentage de la surface 

de l’image), ou pas, et de documenter les limitations de la méthode de validation utilisée. 

Enfin, il faut veiller à ce que les zones de validation soient suffisamment nombreuses et 

réparties de manière homogène sur la carte AFIN QUE CELLES-CI PERMETTENT DE 

CALCULER UNE MATRICE DE CONFUSION QUI SOIT BIEN REPRESENTATIVE DE LA PRECISION 

DE CLASSIFICATION DE L’ENSEMBLE DE L’IMAGE. Par exemple, si vous utilisez une seule 

petite zone de validation pour une classe donnée et que par chance tous les pixels de cette 

zone sont bien classés, la précision de classification obtenue pour cette classe par la matrice 

de confusion sera de 100% alors qu’il est probable que d’autres pixels appartenant à cette 

classe à d’autres endroits de l’image soient eux mal classifiés. Dans ce cas votre zone de 

validation ne sera pas représentative de l’ensemble de la classe d’occupation du sol et 

l’estimation de la précision de classification de cette classe sera donc faussée.  

Dans la cadre de ce TP, par soucis de rapidité et de simplification, les ROIs de validation sont 

dessinés manuellement selon la même procédure que pour les ROIs de calibration (confer ci-

dessus). Cette méthode n’est donc pas optimale au vu des commentaires formulés ci-dessus.  

4.7.4.2 Calcul de la matrice de confusion ou table de contingence 

Le fichier « ROI de validation » servira à la validation de la classification produite (mesure de 

la précision de la classification). La comparaison entre l’occupation du sol classifiée ou 

« prédite » et l’occupation du sol photo-interprétée (ROI de validation) est réalisée par la 

construction et la discussion d’une matrice de confusion (ou table de contingence). En 

principe le nombre de point / pixel pour réaliser la calibration et la validation de l’image doit 

suivre des règles statistiques, ce que vous n’aurez pas nécessairement suivi dans ce cas-ci. 

 Cliquez sur « Classification > Post Classification > Confusion Matrix > Using Ground 

Thruth ROI » 

 Sélectionnez l’image classifiée et le fichier ROI de validation avec l’onglet « Open » 

 Dans la fenêtre « Match Classes Parameters », créez les liens entre les ROIs de 

validation (par exemple: « foret_val ») et de calibration (par exemple: « Foret_cal »). 

 Cliquez « OK »  
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La matrice de confusion apparait. 

Deux exemples de matrice de confusion (structure, interprétation et définition des 

paramètres calculés) sont donnés en Annexe 2 et 3. 

4.7.5 Post-traitement d’une image classifiée pour améliorer le 

rendu visuel 

Plusieurs opérations de post-traitement peuvent être appliquées sur une image classifiée en 

vue d’en améliorer le rendu visuel par exemple. Pour une information détaillée sur les 

opérations de post-traitement, référez-vous à l’aide d’ENVI (Index : « Post classification »).  

Voici 3 opérations qui permettent d’améliorer le rendu visuel d’une image classifiée : 

 Pour diminuer l’effet poivre et sel typique d’une classification par pixel, utilisez une 

analyse majoritaire via le menu « Classification > Post Classification > 

Majority/Minority Analysis ». 

 Pour fusionner différentes classes (par exemple 2 classes se rapportant à la même 

utilisation du sol (agriculture) mais ayant des signatures spectrales différentes (terre 

labourée et champ de maïs) utilisez le menu « Classification > Post Classification > 

Combine Classes ». 

 Pour changer les couleurs de certaines classes, utilisez le menu “Tools > Color 

Mapping > Class Color Mapping ». Choisissez des couleurs intuitives pour chacune 

des classes (par exemple : vert foncé pour la classe « forêt », bleu pour la classe 

« eau », etc.) 

4.7.6 Réalisation d’une carte d’occupation du sol - Mise en page 

cartographique 

Il est possible de réaliser une mise en page cartographique simple dans ENVI. Cependant des 

logiciels comme QGIS ou ArcMap (ArcGIS de la firme ESRI) permettront de réaliser une 

meilleure mise en page.   

4.7.6.1 Mise en page cartographique dans ENVI (limité) 

Pour ajouter des éléments de mise en page cartographique sur une image (image classifiée 

par exemple) : 

 Ouvrez l’image dans une fenêtre de visualisation 

 Allez dans le menu de cette fenêtre « Overlay / Annotation… » 
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 Dans la fenêtre qui s’ouvre, dans le menu « Object », choisissez le type d’objet que 

vous voulez ajouter (texte, légende (« Map Key »), échelle, forme, flèche du Nord, 

etc) 

 Modifiez éventuellement les paramètres de l’objet 

 Cliquez gauche sur l’image à l’endroit où vous voulez insérer l’objet sélectionné 

 Cliquez droit sur l’image pour valider l’insertion de l’objet 

 Répétez ces opérations pour un autre objet 

Pour plus d’information sur l’insertion d’objets sur une image, voyez dans l’aide d’ENVI, dans 

l’index : « Annotation / Adding Annotations ». 

4.7.6.2 Exportation d’une image depuis ENVI (facultatif) 

Une fois votre image classifiée dans ENVI, vous pouvez éventuellement (facultatif) exporter 

le résultat, par exemple, si vous désirez utiliser votre image classifiée dans un document 

Word. Pour ce faire, 

 Chargez votre image classifiée dans une nouvelle fenêtre de visualisation 

 Cliquez, dans le viewer contenant votre classification, sur  « File > Save Image As… > 

Image File »  

 Ignorez le message d’erreur qui apparait, s’il apparait 

 Choisissez « JPEG » comme « Output File Type » (d’autres formats sont disponibles) 

 Indiquez un répertoire de sortie correct 

4.7.6.3 Mise en page cartographique dans QGIS  

Pour réaliser une mise en page cartographique dans QGIS, il suffit de : 

 Créer un nouveau projet QGIS 

 Y ajouter l’image classifiée dans le format utilisé par défaut par ENVI (pas besoin de 

changer de format) 

 Suivre les indications pour l’édition cartographique dans QGIS présentées dans le 

manuel QGIS disponible ici https://orbi.uliege.be/handle/2268/190559 (section 

« Edition cartographique ») 

4.7.6.4 Mise en page cartographique dans ArcGIS 

Pour réaliser une mise en page dans ArcGIS, il faut : 

 Exporter votre image depuis ENVI dans un format compatible avec ArcMap 

https://orbi.uliege.be/handle/2268/190559
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o Cliquez, dans la barre de menu principale d’ENVI, sur « File > Save File As > ESRI 

GRID ». Ce format (ESRI GRID) est nécessaire pour que les classes d’occupation 

du sol, lors de la mise en page de votre carte dans ArcMap, apparaissent dans la 

symbologie et soient disponibles en tant que « légende ». (Dans ArcMap, vous 

devrez renommer vos classes et en modifier les couleurs si nécessaire).  

o Sélectionnez l’image à exporter 

o Choisissez un répertoire de sortie (dossier « Résultat ») et donnez un nom (moins 

de 13 caractères et caractères simples) à votre image (« VotreNOM_Carte ») 

o Ignorez le message d’erreur et cliquez sur « Ok » 

 Mettre en page la carte dans ArcMap   

o Insérez votre carte dans un nouveau projet ArcMap et passez en mode « Layout 

view ».  

o Respectez les consignes d’édition cartographique données dans le manuel de TP 

SIG ArcGIS disponible ici http://orbi.ulg.ac.be/handle/2268/135775 à la section 

« Edition cartographique ».  

o Pour créer une légende correcte, vous pouvez renommer vos classes et en 

changer les couleurs via le panneau « table des matières » d’ArcMap.   

http://orbi.ulg.ac.be/handle/2268/135775
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4.8 Création de Néo-canaux 

Il est parfois intéressant de créer de nouveaux canaux (« néo-canaux ») à partir d’images car 

les bandes originales peuvent être fortement corrélées entre elles (redondance de 

l’information) et les néo-canaux peuvent mettre en évidence certains types d’occupation du 

sol ou simplement faciliter la distinction entre classes d’occupation du sol. Ci-dessous des 

exemples de créations de nouveaux canaux qui peuvent par la suite être utilisés en 

classification. 

4.8.1 Analyse en Composante Principale (ACP) 

Définition de l’Analyse en composantes principales (ACP) (Source : Wikipedia, 

http://fr.wikipedia.org/wiki/Analyse_en_composantes_principales) 

L'Analyse en composantes principales (ACP) est une méthode de la famille de l'analyse des 

données et plus généralement de la statistique multivariée, qui consiste à transformer des 

variables liées entre elles (dites "corrélées" en statistique) en nouvelles variables décorrélées 

les unes des autres. Ces nouvelles variables sont nommées "composantes principales", ou 

axes principaux. Elle permet au praticien de réduire le nombre de variables et de rendre 

l'information moins redondante. 

Statistiquement parlant, les premières composantes produites expliquent au mieux la 

variabilité - la variance - des données. Lorsqu'on veut compresser un ensemble de 

variables aléatoires, les  premiers axes de l'analyse en composantes principales sont un 

meilleur choix, du point de vue de l'inertie ou de la variance. 

 Cette méthode est particulièrement indiquée lorsque le nombre de bandes 

spectrales est important (image hyperspectrale), mais pas seulement.  

 Utilisez l’image hyperspectrale CHRIS-PROBA de 62 bandes (répertoire : « … 

\DATA\HYPERSPECTRAL IMAGE CHRIS PROBA ») en demandant la production de 62 

bandes PCA en sortie. 

 Menu « Transform > Principal Component > Forward PC rotation > Compute new 

statistics and rotate » 

 Visualiser et comparer : 

 Une composition colorée RGB des 3 premières composantes (bandes 1 à 3 du 

résultat) : image très nette et contrastée, riche en information. 

http://fr.wikipedia.org/wiki/Analyse_en_composantes_principales
http://fr.wikipedia.org/wiki/Analyse_des_donn%C3%A9es
http://fr.wikipedia.org/wiki/Analyse_des_donn%C3%A9es
http://fr.wikipedia.org/wiki/Statistique_multivari%C3%A9e
http://fr.wikipedia.org/wiki/Variance_(statistiques_et_probabilit%C3%A9s)
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o Une composition colorée RGB des 3 dernières bandes : très bruyante, pauvre en 

information. 

o Observations à mettre en relation avec le graphique « PC Eigenvalues » 

automatiquement généré. 

4.8.2 Création d’un indice « NDVI » 

 Menu « Transform > NDVI » et sélectionner les bandes correspondant au rouge et au 

PIR. 

 Cet indice est particulièrement utile pour l’étude de la végétation. 

4.8.3 Création d’un indice « Tasseled Cap » 

La transformation de « Tasseled cap » est utile pour compresser des données spectrales en 

quelques bandes associées à des caractéristiques physiques d’une image (Crist and Cicone 

1984). 

 Ouvrez dans ENVI l’image Landsat 7 ETM+ disponible dans le répertoire 

« …\DATA\TASSELED CAP\LANDSAT7\L71186058_05820030227/» via le menu « File 

> Open External File > Landsat > GeoTIFF with Metadata » en choisissant le fichier 

texte qui contient les métadonnées « L71186058_05820030227_MTL.txt ». 

 (Remarque : la composition colorée RGB 753 permet un bon aperçu de l’image.)  

 Utilisez le menu «  Transform > Tasseled cap » 

o Utilisez le fichier texte « L71186058_05820030227_MTL.txt » correspondant à 6 

bandes spectrales de l’image Landsat (« Dims: 7811 x 6991 x 6 [BSQ] ») 

o Pour les images Landsat 7 ETM, la transformation de « Tasseled cap » produit 6 

bandes: Brightness, Greenness, Wetness, Fourth (Haze), Fifth, Sixth (voir Envi 

Help). « This type of transformation should be applied to calibrated reflectance 

data rather than applying to raw digital number imagery” (ENVI help). 

 Visualisez et commentez les images obtenues par la transformation de Tasseled Cap. 

 Remarque : pour les versions d’ENVI (exemple : ENVI 4.5) ne permettant pas 

l’ouverture de l’image LANDSAT avec le fichier qui contient les métadonnées, il faut 

ouvrir l’image par le menu classique, faire ensuite un « Layer Stacking » (menu 

« Basic Tools > Layer Stacking ») des bandes de résolution spatiale de 30 m et 

réaliser le calcul de l’indice de « Tasseled Cap » à partir de cette image comme 

indiqué ci-dessus. 
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Plus d’informations sur cette transformation sont disponibles dans l’article « DERIVATION OF 

A TASSELED CAP TRANSFORMATION BASED ON LANDSAT 7 AT-SATELLITE REFLECTANCE » 

fourni dans le dossier « TASSELED CAP » ou sur internet. 

4.8.4 Création d’autres indices 

L’outil « Basic tools > Band Math » permet de calculer des indices personnalisés. Pour ce 

faire, il faut d’abord écrire l’équation correspondant à un indice donné avec des variables 

correspondantes aux bandes spectrales, par exemple « b1 + b2 », et ensuite attribuer à 

chaque terme de l’équation une bande spectrale d’une image donnée. 
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4.9 Séparabilité spectrale des classes d’occupation du 

sol sur une image 

Pour cette partie, vous travaillerez sur l’image « SPOT_10m_Namur.tif ». Vous pouvez vous 

aider des ROIs complémentaires fournis dans le dossier « SEPARABILITE ». 

4.9.1 Calcul de la séparabilité spectrale de classes d’occupation du 

sol 

Lors de la création de ROI pour une classification supervisée, il est possible d’étudier la 

séparabilité des classes identifiées par les ROIs. Ce qui donne une idée de la possibilité de 

distinguer ces classes et donc de produire une classification précise. 

Pour faire une analyse de séparabilité spectrale des classes d’occupation du sol : 

 Ouvrez l’image d’intérêt, dans ce cas-ci, l’image « SPOT_10m_Namur.tif ». 

 Appelez la fenêtre de gestion des ROIs via « Click droit sur l’image > ROI Tool » 

 Ouvrez les ROIs correspondant aux classes à étudier, dans ce cas-ci, le fichier 

« ROI_CLASSES_SEPARABILITY.roi» (ROIs correspondants à différentes classes 

d’occupation du sol). 

 Passez en revue ces ROIs à l’aide du bouton « Goto » dans la fenêtre « ROITool » 

 Réalisez une analyse de séparabilité des classes présentes dans ces ROIs via le menu, 

dans  la fenêtre de gestion des ROIs, « Options > Compute ROI separability… > 

select image > select class > select all classes» 

 Analysez le tableau en sortie ! 

o 2 indices de séparabilités sont calculés dans ENVI (confer ENVI Help - Index : ROIs 

/spectral separability) : 

o  « Jeffries-Matusita » 

o «  Transformed Divergence » 

o La valeur de ces indices varie entre [0 - 2]. Une valeur > 1.9 indique une bonne 

séparation entre 2 classes données. 

 Quelles sont vos conclusions? 
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4.9.2 Distribution spectrale dans un graphique 2D (2D Scatter plot) 

L’outil « 2D Scatter Plot » permet de visualiser la distribution des valeurs des pixels dans un 

graphique 2D. Plusieurs options sont disponibles : comparaison de 2 bandes spectrales, 

d’une bande par rapport à des ROIs ou à une classification (Figure 22). Cet outil est disponible 

via le menu « Tools > 2 D Scatter Plots… » d’une fenêtre de visualisation d’une image. 

 Comparaison de 2 bandes   

o Ouvrir l’image à analyser dans une fenêtre de visualisation 

o Appeler l’outil « Tools > 2 D scatter Plots… » de la fenêtre de visualisation de 

l’image 

o Sélectionner les 2 bandes à comparer (« Band X » and « Band Y ») 

correspondantes aux axes X et Y du graphique 

o Par défaut le nuage de points est blanc.  

o Le graphique est interactif avec les fenêtres de visualisation. Se déplacer dans 

une fenêtre modifiera le nuage de points.  

o Possibilité de représentation par des couleurs dans le nuage de points de zones 

de l’image (classes d’occupation du sol par exemple) particulières. Cela donne 

une idée de leur position dans un nuage de point plus global. 

o En survolant et cliquant sur l’image (« Options > Dance »). Les pixels 

correspondants apparaissaient en rouge dans le nuage de points. 

o En utilisant des ROIs préexistants (« File > Import ROIs… »). La localisation 

des pixels des ROIs dans le nuage de points se fait en couleur en fonction 

des couleurs attribuées aux ROIs (Figure 22, en bas). Il peut être 

intéressant d’agrandir la fenêtre « image » au maximum pour visualiser un 

maximum de ROIs. 

o En utilisant des ROIs dessinés interactivement sur l’image (« Options > 

Image : ROI »)  

o L’option « Options > Density Slice » et « Options > Select Density 

Lookup… » permettent de colorer le nuage de points en fonction de sa 

densité (Figure 22, centre-haut). 

 Comparaison d’une bande par rapport à une classification (Figure 22, à droite).  

o Ouvrir une image classifiée dans une fenêtre de visualisation 

o Appeler l’outil « Tools > 2 D scatter Plots… » de la fenêtre de visualisation de 

l’image 

o Sélectionner les 2 bandes à comparer (« Band X » and « Band Y ») 

correspondantes aux axes X et Y du graphique avec une des bandes qui 

correspond à une image classifiée. 
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o Le graphique produit présente la distribution des valeurs de pixels d’une bande 

dans les différentes classes de l’image et donne une idée de leur séparabilités 

pour une bande donnée. 

 

 
Bande 1 versus Bande 1 

 
Bande 1 versus Bande 4 (Density 

Slice = Rainbow) 

 
Bande 2 versus classes d’une 

image classifiée 

 

 
Bande 2 versus Bande 4 avec ROIs importés 

 
Figure 22 : différentes utilisations de l’outil « 2D Scatter Plot » 

 

Aide à l’interprétation du dernier graphique de la Figure 22 (en bas à droite) ci-dessus : 

 Chaque axe du graphique correspond à une bande spectrale de l’image, c’est-à-dire à 

une gamme de longueurs d’onde 

 Chaque couleur correspond à une classe d’occupation du sol (la couleur correspond à 

la couleur choisie pour chaque classe lors de la création de ROI) 

 La superposition/distinction des nuages de points de 2 différentes 

couleurs/occupation du sol dans le graphique 2 D donne une indication sur la 

séparabilité spectrale de ces classes dans les 2 bandes spectrales considérées.  
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o Si les nuages de points de 2 différentes couleurs/occupation du sol sont séparés 

selon les 2 axes dans le graphique 2 D (pas de superposition), alors les 2 classes 

sont spectralement séparables dans ces 2 gammes de longueurs d’onde. 

o Une classe peut être séparable selon une gamme de longueurs d’onde et pas 

selon l’autre. Dans ce cas les nuages de points seront séparés selon un axe et 

confondus selon l’autre axe. 

o Si les 2 nuages de points se superposent selon les 2 axes alors les classes ne sont 

pas séparables selon ces 2 gammes de longueurs d’onde.  

4.9.3 Calcul de statistiques par ROI 

 Pour calculer la superficie (~ nombre de pixels) par classe selon les ROIs (par exemple 

pour vérifier que le nombre de pixels par classe de ROI est suffisant selon les règles 

de l’échantillonnage) 

 « ROI Toool > Options > Report Area of ROI  > m² » 

 Analyse du tableau (superficie par classe dans les ROIs) 

4.9.4 Courbes de distribution des valeurs de pixels par classe ou 

bande spectrale 

Une fois une image classifiée, il est possible de : 

 Comparer les distributions des valeurs des pixels de toutes les bandes spectrales 

pour une même classe (Figure 23, graphique de gauche). 

 Comparer les distributions des valeurs des pixels d’une bande spectrale pour toutes 

les classes (Figure 23, graphique de droite).  

Ceci est particulièrement intéressant pour identifier les classes multimodales / unimodales !! 

Le menu à utiliser est : « Classification > Post Classification > Class Statistics » 

 Réalisez d’abord une classification supervisée de l’image avec les ROIs du fichier 

« ROI_CLASSES_SEPARABILITY.roi » 

 Utilisez ensuite le menu « Classification > Post Classification > Class Statistics » en 

indiquant comme : 

 « Classification Input File », l’image classifiée, puis comme  

 « Statistics Input File » l’image originale.  

 Sélectionnez ensuite les classes d’intérêts (toutes), et demandez la création de 

« Basic Stats », « Histograms », « Covariance » et « Covariance image ». Et cliquez sur 

« OK ». 

 2 fonctions sont particulièrement intéressantes : 
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o « Select Plot > Histogram: All Bands », et sélectionner une classe dans le menu 

supérieur (Figure 23, à gauche) 

o « Select Plot > Histogram for all classes > Band 1 », par exemple (Figure 23, à 

droite) 

 Le rendu visuel du graphique n’est pas toujours adapté par défaut. Il faut souvent 

modifier l’échelle des ordonnées (axe Y) du graphique. Pour ce faire, faites un clic 

droit près de l’axe, puis « Edit > Plot Parameters > Y Axis » et réduire le range 

(50 000 par exemple) pour que les courbes apparaissent correctement. 

 Les statistiques par classe et par bande sont disponibles dans le tableau en-dessous 

des graphiques de la Figure 23, avec corrélation entre les bandes, valeurs de 

distribution des pixels par bande, min, max, mean, etc. 

 Possibilité de sauver le graphique en format jpeg. 

 

 
1 classe (champs mixtes), 4 bandes spectrales 

 
8 classes, 1 bande spectrale (bande 3) 
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Figure 23 : courbes de distribution des valeurs de pixels par bande spectrale ou classe 

d’occupation du sol d’une image classifiée et tableau de statistiques 
 

Aide à l’interprétation du graphique de droite de la Figure 23 ci-dessus : 

 Description du graphique : 

o Chaque courbe correspond à une classe d’occupation du sol identifiée dans les 

ROI 

o L’axe X est exprimé en DN (Digital Numbers, valeurs encodées dans les pixels) 

dont la valeur est proportionnelle à la réflectance ou à la radiance 

o L’axe Y correspond au nombre de pixels ayant une certaine valeur de DN 

o Les surfaces sous les courbes sont proportionnelles aux superficies des classes 

d’occupation du sol dans l’image 

o Une seule bande spectrale ou gamme de longueurs d’onde est considérée par 

graphique 

 Interprétation en termes de séparabilité spectrale :  

o Si 2 courbes se superposent selon l’axe X, les classes d’occupation du sol 

correspondantes ont donc la même gamme de valeurs de réflectance/radiance et 

sont donc inséparables 

o Si 2 courbes ne se superposent pas du tout selon l’axe X, les classes d’occupation 

du sol correspondantes ont donc des gammes de valeurs de réflectance/radiance 

différentes et sont donc parfaitement séparables 
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o Si l’on observe une situation intermédiaire, lorsque les courbes se superposent 

partiellement selon l’axe X, il y a une séparabilité partielle.  

4.9.5 Classes spectrales uni-modales et multimodales 

Cette section a pour but de mettre en évidence, à travers des graphiques, le caractère 

multimodal que peuvent prendre les courbes de distribution des valeurs de pixels de classes 

d’occupation du sol mixtes (classes caractérisées par plusieurs comportements spectraux 

différents dus aux différentes occupations du sol contenues dans la classe). 

Pour ce faire : 

 Ouvrir l’image à analyser dans une fenêtre de visualisation, dans ce cas-ci, l’image 

« SPOT_10m_Namur.tif ». 

 Visualisez la bande 4 de l’image en dégradé de gris dans une fenêtre 

 Réalisez 2 classes de ROIs : 

o Classe « BLACK_WHITE_B4 » correspondant à des zones apparaissant comme très 

foncées ou très claires dans la bande B4 (pixels ayant des valeurs extrêmement 

faibles ou élevées dans la bande B4). Cette classe correspondra à au moins 2 

classes spectrales différentes aura un comportement bi- (ou multi) modal.  

o Classe « GRAY_B4 » correspondant à des zones grise dans la bande B4 (pixels 

ayant des valeurs moyennes dans la bande B4). 

o Réalisez une classification supervisée de l’image en utilisant ces 2 classes. 

o Réalisez un graphique comparant la distribution des valeurs des pixels de la 

bande B4 pour ces 2 classes (confer ci-dessus, la section 4.9.4) (Figure 24 : 

Courbes de distribution des valeurs de pixels uni- et tri-modales). 

o Analysez les formes des courbes. 

 Un menu similaire est disponible via : « Basic Tools > Statistics > Compute Satistics > 

Sélectionner l’image classifiée > Cochez « Histograms > Ok > Select Plot > Histogram 

band 1 ». 

  

Figure 24 : Courbes de distribution des valeurs de pixels uni- et tri-modales 
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4.10 Manipulation de données hyperspectrales 

Dans cette section vous aurez brièvement l’occasion de manipuler quelques données de 

type « hyperspectral ». Un signal est dit « hyperspectral » lorsqu’il est composé de 

nombreuses bandes spectrales (généralement 100 ou plus), étroites (1 à 500 nm de largeur 

par exemple) et contiguës (signal continu dans la gamme spectrale considérée) (Figure 26). 

Les données hyperspectrales peuvent se présenter de différentes façons en fonction du 

capteur duquel elles sont issues (Figure 25) : 

 Image hyperspectrale : il s’agit d’une image (comme une image satellite 

multispectrale par exemple) avec une résolution spectrale très importante. Exemple : 

le capteur “AHS-160” est disposé dans un avion et est composé de 80 bandes 

spectrales, couvrant 5 parties du spectre solaire entre 0.43 – 12.7 µm 

(VIS+NIR+SWIR+TIR). 

 Donnée hyperspectrale ponctuelle : ces données sont enregistrées à l’aide d’un 

capteur portable utilisé par un opérateur directement sur le terrain (en plein air ou 

en laboratoire). Exemple : capteur de type « Analytical Spectral Device (ASD) », qui se 

porte comme un sac à dos et enregistre l’information spectrale dans 2151 bandes 

spectrales contigües de 1 nm de large chacune, entre 350 et 2500 nm. 

 

Figure 25 : Différents types d’acquisitions de données hyperspectrales 
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4.10.1 Manipulation de données hyperspectrales ponctuelles (ASD) 

Les données que vous allez utiliser ont été acquises sur des échantillons de sol agricoles 

étudiés en laboratoire pour différents niveaux d’ombrages et de teneur en eau. 

Le logiciel à utiliser est « ViewSpecPro ». Ce logiciel gratuit peut être téléchargé à l’adresse 

web suivante : https://www.malvernpanalytical.com/fr/support/product-

support/software/ViewSpecProSoftwareInstall.html après inscription sur ce site.  

Les fichiers se trouvent dans le répertoire « DATA\HYPERSPECTRAL ASD LABO »: 

 Naviguez vers ce répertoire (via Windows) et ouvrez le fichier texte 

« Exemple_fichier_hyperspectral_texte.txt ». Il vous donne un aperçu de comment 

peut être organisé l’information spectrale dans un fichier : une colonne pour les 

longueurs d’ondes (nm) et une pour les valeurs de réflectance. Expliquez les valeurs 

de ces deux colonnes. 

 Démarrez le logiciel « ViewSpecPro » 

 Cliquez sur « File > Open > » et naviguez jusqu’au répertoire contenant les données 

hyperspectrales 

 Sélectionnez les 4 fichiers dont le nom commence par « Ombre… ». et cliquez sur 

« Ouvrir » 

Les fichiers sélectionnés devraient apparaitre dans la fenêtre principale de « ViewSpecPro » 

 Sélectionnez tous les fichiers et cliquez sur « View > Graph Data ». 

Les spectres correspondants aux fichiers sélectionnés s’affichent à l’écran. 

Selon vous quels sont les spectres correspondants à un ombrage et une teneur en eau 

élevés ? Pourquoi ? 

https://www.malvernpanalytical.com/fr/support/product-support/software/ViewSpecProSoftwareInstall.html
https://www.malvernpanalytical.com/fr/support/product-support/software/ViewSpecProSoftwareInstall.html
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Figure 26 : Signatures spectrales pour différents matériaux dans la gamme de longueur d’ondes 
[0.5µm -3µm] 
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4.10.2 Manipulation de données hyperspectrales images (CHRIS-

PROBA) 

4.10.2.1 Présentation de l’image hyperspectrale 

L’image que vous allez utiliser a été acquise par le capteur CHRIS (Compact High Resolution 

Imaging Spectrometer) monté sur le satellite PROBA (Project for On Board Autonomy). Il 

enregistre les images dans 62 bandes spectrales comprises dans l’intervalle [400 nm - 1000 

nm]. Plus d’information sur le couple CHRIS-PROBA est disponible aux pages web suivantes : 

 https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba, ESA 

earthnet online (ESA = European Space Agency) 

 https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1  

L’image se trouve dans le dossier « …\HYPERSPECTRAL IMAGE CHRIS PROBA » et est 

nommée «CH100728_N.BIN ».  Elle a été enregistrée le 28 juillet 2010 au-dessus d’une 

région agricole au Sud-Ouest de Leipzig (Allemagne) en position « NADIR » (« N ») (capteur à 

la verticale du lieu enregistré). L’extension « .BIN » signifie que l’image est codée en binaire.  

Différents fichiers accompagnent ce fichier image : 

 CH100728_N.HDR, le fichier header créé dans ENVI 

 CH100728_N.hea, un fichier header pour un autre logiciel (autre format) 

 QuicklookCEF4_Leipzig_2010-07-28.jpg, une illustration jpeg basse résolution de 

l’image aussi appelé « Quicklook » pour avoir un aperçu de l’image sans devoir 

utiliser un programme spécialisé. 

 Info Chris wavelengths.xls listant chacune des 62 bandes de l’image avec les 

longueurs d’ondes correspondantes 

 Readme.txt donnant quelques informations supplémentaires sur l’image (nombre de 

lignes et de colonnes, système de coordonnées, format, etc) 

4.10.2.2 Manipulations et analyses à partir de l’image hyperspectrale 

Ouvrez l’image « CH100728_N.BIN ». Constatez que cette image est composée de 62 bandes 

spectrales. Chargez l’image en composition RGB dans une nouvelle fenêtre de visualisation. 

Essayez différentes combinaisons de bandes dont une composition vraie couleur (exemple 

de réponse : R = 21, G = 14, B = 5).  

Y a-t-il une seule possibilité de composition vraie couleur ?  

https://earth.esa.int/web/guest/missions/esa-operational-eo-missions/proba
https://directory.eoportal.org/web/eoportal/satellite-missions/p/proba-1
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Remarquez la présence importante de nuages sur l’image.  

Jetez un œil aux informations contenues dans le « Header file » via un clic droit sur le nom 

de l’image dans la fenêtre « Available Band List » et choisissez « Edit Header …».  Pour 

constater l’importance du « header file » changer un paramètre du header, recharger une 

composition colorée de l’image et constater le changement dans la fenêtre de visualisation. 

Remodifiez les valeurs du « header file » pour afficher correctement l’image dans une 

nouvelle fenêtre de visualisation. 

Utilisez l’outil « Tools > Animation » pour visualiser automatiquement les 62 bandes l’une 

après l’autre et constater les différences spectrales des bandes pour une occupation du sol 

donnée. 

Utilisez l’outil « Tools > 2D Scatter Plot » pour grapher les valeurs de 2 bandes spectrales en 

x et y. Faites-le pour les combinaisons de bandes suivantes : 

 Bande 1 et bande 2 

 Bande 1 et bande 42 

Quelles différences observez-vous entre ces 2 graphiques ? Comment les expliquez-vous ? 

Utilisez l’outil «  Tools > Profiles > Z Profile (Spectrum)… » qui permet d’extraire le spectre 

(composé par les 62 bandes de l’image) en 1 pixel donné. Comparez et commentez les 

spectres de différentes occupations du sol et des nuages. 

Construisez un « 3D hyperspectral Cube » via le menu « Spectral > Build 3D Cube  >... » 

dans le menu principal d’ENVI : 

 Choisissez l’image « CH100728_N.HDR » comme « 3D Cube Input File », sans 

« spectral subset » 

 Choisissez ensuite les 3 bandes de l’image qui correspondront à la « façade » du cube 

hyperspectral 

 Réalisez un « spatial subset » pour que les bordures supérieur et de droite de votre 

spatial subset intersectent l’image via le bouton « image » du menu « Select Spatial 

Subset » 

 Choisissez ensuite une « table de couleur » et un répertoire de sortie et nommez 

votre fichier. 

 Chargez ensuite le cube hyperspectral dans une nouvelle fenêtre de visualisation et 

analysez le comportement hyperspectral des différentes occupations du sol. 
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5 Visionnage de la vidéo « HOLOGLOBE » 

Cette petite vidéo d’animation de la NASA, d’une durée de 6 minutes, en anglais, montre, 

sur un globe terrestre tournant, la dynamique de plusieurs phénomènes d’origine naturelle 

ou anthropique (Figure 27). 

Cette vidéo est réalisée en grande partie à partir de données issues de satellites 

d’observation de la terre. Entre autres, les phénomènes suivants sont illustrés: 

 Dynamique des flux d’énergie de la terre (mouvements atmosphériques (formation 

des ouragans), courants marins, etc 

 Dynamique des températures des océans et phénomène El Nino 

 Croute et plaques terrestres, tremblements de terre et volcans 

 Saisons et dynamique de la végétation 

 Vision nocturne de l’influence de l’homme sur la terre (lumière artificielle, incendies, 

agriculture sur brulis, combustion de gaz, etc) 

La traduction des commentaires de cette vidéo sont disponibles en Annexe 4, page 100. 

Cette vidéo, et une série d’informations complémentaires, sont disponibles sur le site web 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/. 

 

 

Figure 27 : illustrations issues de la vidéo « Hologlobe » : mouvements atmosphériques, 
végétation, température des océans. 

 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/
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6 Recherche d’images satellites sur le web 

Une des premières étapes de tout travail en télédétection spatiale est de se procurer les 

images satellites à partir desquelles votre étude pourra être menée. Cette section à pour 

objectif de vous introduire à la recherche d’images sur le web. 

Avant de commencer votre recherche d’images, il est important que vous cerniez clairement 

quel sont vos objectifs (en termes de résultats) et quels sont vos moyens (connaissance, 

argent, temps).  

Au cours de vos recherches, vous devrez trouver un juste compromis entre ce que le web 

vous « offre » et ce que vous recherchez. En particulier, vous ferez très attention aux critères 

suivants:  

 Type d’image pertinente pour répondre à vos objectifs en termes de résolution 

spatiale, temporelle et spectrale. 

 Disponibilité d’images pour la zone et l’époque sur lesquelles vous voulez travailler 

(couverture nuageuse) 

 Prix des images (gratuit vs très cher !) 

GOOGL EARTH (gratuit) : 

Vous pouvez enregistrer (sur votre disque dur) les images qui apparaissent à l’écran lors de 

votre visite dans Google Earth. Pour ce faire, après avoir zoomé sur le lieu d’intérêt, cliquez 

sur « Fichier/Enregistrez/Enregistrez l’image/… » et vous pourrez sauvegarder la vue en 

format « jpg ». Attention, l’image que vous enregistrez par cette opération n’est donc pas 

une image satellite en tant que telle, mais une simple « capture d’écran » de l’image telle 

qu’elle est affichée sur votre écran. L’information spectrale contenue dans cette image jpg 

est donc  beaucoup plus pauvre que celle contenue dans une image satellite réelle. De plus 

l’image jpg ne sera pas géoréférencée, et la résolution spatiale de l’image dépendra du zoom 

que vous avez utilisé lors de la capture d’écran. Vous devrez donc tenir compte de ces 

limitations si vous comptez utiliser des images dérivées de Google Earth. Un exemple 

d’utilisation d’images de Google Earth : image pour fond de carte à but illustratif. 

USGS EARTH EXPLORER (gratuit) 

 http://earthexplorer.usgs.gov/  

 USGS Earth Explorer, catalogue de la « United States Geological Survey » (USGS), 

donne accès à de nombreux types d’images dont les images : 

o LANDSAT 

http://earthexplorer.usgs.gov/
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o ASTER : altitude, température, réflectance (14 bandes spectrales)  

o https://asterweb.jpl.nasa.gov/  

o https://asterweb.jpl.nasa.gov/characteristics.asp 

o Données d’ALTITUDE : DEM (Digital Elevation Model) ou MNT (Modèle 

Numérique de Terrain) pour l’ensemble de la planète à ~30 mètres de résolution 

spatiale via l menu « Data Sets > Digital Elevation > SRTM » 

o Toute une série de cartes thématiques (occupation du sol,…) 

o RADAR 

o … 

NASA EARTHDATA (gratuit) 

 https://earthdata.nasa.gov/  

 Grande variété de données, dont des images issues de la télédétection, dont le 

Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) Global 

Digital Elevation Model (GDEM), un DEM global à 30 mètre de résolution spatiale 

(info ici https://asterweb.jpl.nasa.gov/gdem.asp)  

COPERNICUS:  Copernicus is a European system for monitoring the Earth (gratuit) 

 Page principale d’accès aux produits Copernicus « Land » 

o https://land.copernicus.eu/  

 Produits végétation, dont le NDVI 

o https://land.copernicus.eu/global/themes/vegetation   

 Sentinel Hub : accès facile aux données Sentinel du programme Copernicus 

o Page principale 
o https://www.sentinel-hub.com/  

o EO Browser 
o https://www.sentinel-hub.com/explore/eobrowser  

IMAGES BASSE RESOLUTION : SPOT VEGETATION, METOP-AVHRR, PROBA-V (gratuit): 

 http://www.vito-eodata.be/PDF/portal/Application.html#Home , S’enregistrer, 

Rechercher un produit, le télécharger et le visualiser dans un viewer 

 VGT extract : logiciel à télécharger (avec java) 

(https://rs.vito.be/africa/en/software/Pages/vgtextract.aspxhttp://www.vgt4africa.or

g/VGTExtract.do) et installer sur votre pc. Cet outil permet d'extraire du dossier 

zipper, uniquement les canaux que l'on désire, de découper spatialement les images 

selon une région d'intérêt définit par l'utilisateur ou préenregistrée et de convertir 

les données dans un format plus facile à utiliser (ENVI, géotiff, ERMapper ...) Logiciel 

« Crop VGT » disponible pour les pays non africains. 

PLANET.COM (gratuit et payant) 

 https://www.planet.com/ 

https://asterweb.jpl.nasa.gov/
https://asterweb.jpl.nasa.gov/characteristics.asp
https://earthdata.nasa.gov/
https://asterweb.jpl.nasa.gov/gdem.asp
https://land.copernicus.eu/
https://land.copernicus.eu/global/themes/vegetation
https://www.sentinel-hub.com/
https://www.sentinel-hub.com/explore/eobrowser
http://www.vito-eodata.be/PDF/portal/Application.html#Home
https://rs.vito.be/africa/en/software/Pages/vgtextract.aspx
https://rs.vito.be/africa/en/software/Pages/vgtextract.aspx
http://www.vgt4africa.org/VGTExtract.do
https://www.planet.com/
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 Une couverture satellite de la terre entière chaque jour (ou presque) à très haute 
résolution spatiale (0.72 cm)!! 

DIGITALGLOBE (très haute résolution spatial, payant) 

 Page principale du site web: https://www.digitalglobe.com/  

 Portail de recherche d’images : 

https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED95749275

03AD11E38FBEA6237? 

AIRBUS DEFENSE AND SPACE – SPOT IMAGE : 

 Page principale 

o https://www.intelligence-airbusds.com/geostore/ 

 Navigation et recherche de produits 

o http://www.geo-airbusds.com/en/4871-browse-and-order 

 produits spot, autres satellites, spot scene et spot view, fiches techniques, etc 

 http://www.geo-airbusds.com/fr/  

 En 1994, le CNES (Centre National d’Etudes Spatiales français) a lancé le programme 

ISIS (Incitation à l'utilisation Scientifique des Images Spot), destiné à faciliter l'accès 

à l'imagerie Spot pour l'ensemble de la communauté scientifique, en lui permettant 

d'acquérir ces données satellitaires à un tarif préférentiel. ISIS est accessible à tout 

chercheur et étudiant travaillant dans un laboratoire européen.  

 https://www.theia-land.fr/le-programme-isis-du-cnes-sintegre-a-dinamis/   

 https://www.theia-land.fr/   

PPNC – Plan Photographique Numérique Communal (Belgique) (gratuit) 
La Région Wallonne met à disposition du grand public toute une série d’information de type 

géographique (carte thématique, MNT, etc) sur des serveurs web de type ArcIMS accessible 

en mode « lecture seule » via ArcGIS. 

 Démarrez un projet ArcGIS et référez vous aux notes de TP relatives à ArcGIS 

(disponible ici : http://orbi.ulg.ac.be/handle/2268/135775) à la section « Ajouter des 

données ». 

AUTRES (gratuit): 

 Africa data dissemination service 

 http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a 

  Site de BELSPO: liste de satellite et liens 

 http://eo.belspo.be/Directory/Satellites.aspx  

 exemples : CORONA, IKONOS2, NOAA, Airborne platform-Apex, MSG3, 

PROBA-CHRIS, ENMAP 

https://www.digitalglobe.com/
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
https://browse.digitalglobe.com/imagefinder/main.jsp;jsessionid=7AB20ED9574927503AD11E38FBEA6237
https://www.intelligence-airbusds.com/geostore/
http://www.geo-airbusds.com/en/4871-browse-and-order
http://www.geo-airbusds.com/fr/
javascript:openGlossary(161,%20'fr');
https://www.theia-land.fr/le-programme-isis-du-cnes-sintegre-a-dinamis/
https://www.theia-land.fr/
http://orbi.ulg.ac.be/handle/2268/135775
http://earlywarning.usgs.gov/adds/imgbulks3.php?imgtype=nd&spextent=a
http://eo.belspo.be/Directory/Satellites.aspx
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LISTE DE SITES WEB listant des sites web fournissant des images satellites 

 15 Free Satellite Imagery Data Sources 

o https://gisgeography.com/free-satellite-imagery-data-list/  

 50 Satellites You Need To Know: Earth Satellite List  

o https://gisgeography.com/earth-satellite-list/  

 Resources for Finding and Using Satellite Images  

o https://gijn.org/resources-for-finding-and-using-satellite-images/   
 

https://gisgeography.com/free-satellite-imagery-data-list/
https://gisgeography.com/earth-satellite-list/
https://gijn.org/resources-for-finding-and-using-satellite-images/
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7 Sites web intéressants 

7.1 Applications environnementales  

Changement de la couverture forestière mondiale entre 2000-2018 à partir d’images 
Landsat, University of Maryland,  application web. 
http://earthenginepartners.appspot.com/science-2013-global-forest 
 
Quelques exemples de détection de changement avec des images Landsat, vidéo, anglais.  
« A Planetary Perspective: With Landsat and Google Earth Engine ». 
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y  
 
Quelques exemples d’applications environnementales à partir des images Landsat, site web, 
anglais. 
« Environmental Watch with Landsat satellites ». 
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/  
 
Observation mondiale des feux, de la végétation et de la couverture neigeuse à partir des 
images MODIS NDVI, NASA, entre Juillet 2002 et Juillet 2011. 
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=3868   

7.2 Supports pédagogiques 

Des supports pédagogiques disponibles en ligne sont recensés par le pôle Theia pour les 
personnes qui souhaitent se former ou former à la télédétection et à ses applications. 

 https://www.theia-land.fr/supports-pedagogiques/  

 

Applied Remote Sensing Training by NASA 

 https://arset.gsfc.nasa.gov/ 

 

Newcomers Earth Observation Guide 

 https://business.esa.int/newcomers-earth-observation-guide 

 The aim of this guide is to help non-experts in providing a starting point in the 

decision process for selecting an appropriate Earth Observation (EO) solution. 

7.3 Divers 

Programme belge “STEREO” 

http://earthenginepartners.appspot.com/science-2013-global-forest
http://www.youtube.com/watch?v=Ezn1ne2Fj6Y
http://www.nasa.gov/content/goddard/environmental-watch-with-nasa-s-landsat-satellites/
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=3868
https://www.theia-land.fr/supports-pedagogiques/
https://arset.gsfc.nasa.gov/
https://business.esa.int/newcomers-earth-observation-guide
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 Belgium has its very own national program supporting research in Earth observation 

called STEREO (Support To Exploitation and Research in Earth Observation). 

Documentation sur tous les projets STEREO disponible ici: 

 https://eo.belspo.be/en/stereo-in-action  

 
Le film documentaire “HOME”, un film de Yann Arthus-Bertrand, 90 minutes, 2009,  

français, disponible gratuitement ici:  

 http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1.  

 Site web du film : http://www.homethemovie.org/. « Ce film développe le lien qui 

unit l'homme à la Terre. Conçu comme un carnet de voyages, il est constitué 

uniquement d'images aériennes et d'une voix off » (Source : Wikipedia). 

 
EARTH as ART, NASA, Top Five, collection de magnifiques images satellites 

 Vidéo en anglais: http://www.youtube.com/watch?v=Tq88dRFokgg  

 Page web : http://www.nasa.gov/connect/ebooks/earth_art_detail.html 

 
Simulation 3D de la couverture nuageuse mondiale durant 7 jours  sur base de données 
réelles, vidéo. 

 https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=i

v&src_vid=JZXErLns1mM&v=zlqjz9OEhk0  

 
Simulation numérique des courants atmosphériques et marins, vidéo, anglais.  
« Dynamic Earth, NASA. » 

 http://www.youtube.com/watch?v=JQZ3QkaWWqA  

 

 

https://eo.belspo.be/en/stereo-in-action
http://www.youtube.com/watch?v=NNGDj9IeAuI&feature=youtu.be&hd=1
http://www.homethemovie.org/
http://fr.wikipedia.org/wiki/Homme
http://fr.wikipedia.org/wiki/Terre
http://www.youtube.com/watch?v=Tq88dRFokgg
http://www.nasa.gov/connect/ebooks/earth_art_detail.html
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
https://www.youtube.com/watch?annotation_id=annotation_397244329&feature=iv&src_vid=JZXErLns1mM&v=zlqjz9OEhk0
http://www.youtube.com/watch?v=JQZ3QkaWWqA
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8 Exemples d’applications de la télédétection 

spatiale pour la gestion des risques et des 

catastrophes 

8.1 Le programme COPERNICUS et le SERTIT 

Présentation générale du programme COPERNICUS (vidéo 4 min 30, anglais) 

 http://www.esa.int/spaceinvidéos/Vidéos/2016/02/Sentinels_for_Copernicus  

 Satellites and examples of application 

 Les données satellites, aériennes, et stations au sol, intégrées dans un même 

système : COPERNICUS 

 Cœur du système = famille de satellites Sentinelle 

 The role of the different 6 sentinel satellites 

 

Copernicus Emergency Management Service (Copernicus EMS) 

 https://emergency.copernicus.eu  

 Copernicus Emergency Management Service (Copernicus EMS) provides information 

for emergency response in relation to different types of disasters, including 

meteorological hazards, geophysical hazards, deliberate and accidental man-made 

disasters and other humanitarian disasters as well as prevention, preparedness, 

response and recovery activities. The Copernicus EMS is composed of: 

o an on-demand mapping component providing rapid maps for emergency 

response and  

o risk & recovery maps for prevention and planning and of the early warning and 

monitoring component which includes systems for floods, droughts and forest 

fires: 

 4 modules constitute the Copernicus EMS: confer https://emergency.copernicus.eu/  

o The Copernicus EMS - Mapping 

o The Copernicus EMS - Mapping addresses, with worldwide coverage, a 

wide range of emergency situations resulting from natural or man-made 

disasters. Satellite imagery is used as the main datasource,  

o https://www.youtube.com/watch?v=NhFZa7gQ2zA    

o Rapid mapping Flood: the Copernicus Emergency Management Service  

o https://emergency.copernicus.eu/mapping/ems/service-overview  

http://www.esa.int/spaceinvideos/Videos/2016/02/Sentinels_for_Copernicus
https://emergency.copernicus.eu/
https://emergency.copernicus.eu/
https://www.youtube.com/watch?v=NhFZa7gQ2zA
https://emergency.copernicus.eu/mapping/ems/service-overview
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o Rapid Mapping consists of the provision of geospatial information within 

hours or days from the activation in support of emergency management 

activities immediately following a disaster. Standardised mapping 

products are provided:  

 to ascertain the situation before the event (reference product),  

 to roughly identify and assess the most affected locations (first 

estimate product),  

 assess the geographical extent of the event (fdelineation product) 

or  

 to evaluate the intensity and scope of the damage resulting from 

the event (grading product). 

o Examples here:  

 https://emergency.copernicus.eu/mapping/list-of-

components/EMSR388  

o Map of active risk:  

 https://emergency.copernicus.eu/mapping/map-of-activations-

risk-and-recovery  

 FLOODS: The European and Global Flood Awareness Systems (EFAS & GloFAS) 

o https://emergency.copernicus.eu/  

o Vidéo, anglais, 8 minutes 

o https://www.youtube.com/watch?v=DwFAjr6f8jQ  

o Short introductory vidéo explaining the structure of EFAS and the main 

objectives using floods in Eastern Europe in May 2010 

o Passer le début: combine précipitation + conditions hydrologiques et fait 

un warning !  

 FOREST FIRE: The European Forest Fire Information System (EFFIS) 

o https://effis.jrc.ec.europa.eu/  

o Visualisation des risques d’incendies:  

o https://effis.jrc.ec.europa.eu/static/effis_current_situation/public/index.h

tml  

 The EMS Drought Observatory (DO) 

o https://emergency.copernicus.eu/  

 

Plusieurs exemples de l’utilisation des satellites dans le cadre de la gestion des crises : 

 https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_man

agement  

https://emergency.copernicus.eu/mapping/list-of-components/EMSR388
https://emergency.copernicus.eu/mapping/list-of-components/EMSR388
https://emergency.copernicus.eu/mapping/map-of-activations-risk-and-recovery
https://emergency.copernicus.eu/mapping/map-of-activations-risk-and-recovery
https://emergency.copernicus.eu/
https://www.youtube.com/watch?v=DwFAjr6f8jQ
https://effis.jrc.ec.europa.eu/
https://effis.jrc.ec.europa.eu/static/effis_current_situation/public/index.html
https://effis.jrc.ec.europa.eu/static/effis_current_situation/public/index.html
https://emergency.copernicus.eu/
https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_management
https://www.esa.int/Applications/Observing_the_Earth/Copernicus/Emergency_management
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 Services for emergency management response will help mitigating the effects of 

natural and manmade disasters such as floods, forest fires and earthquakes and 

contribute to humanitarian aid exercises. 

 

Présentation du SERTIT, le Service régional de traitement d’image et de télédétection  

 http://sertit.unistra.fr/  

o Vidéo, 2 min, français 

 http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-

permet-d-aider-a-la-gestion-des  

o  « Copernicus ou quand l'imagerie satellite permet d'aider à la gestion des 

catastrophes naturelles, 8 juin 2016 » 

o Le SERTIT, impliqué dans le service européen de gestion des situations d’urgence 

Copernicus, explique en vidéo sur la chaîne Euronews comment l’imagerie 

satellite permet de fournir une aide à la gestion des catastrophes naturelles, 

notamment dans le contexte d’inondations en France, Allemagne et en Belgique. 

 Vidéo de présentation du SERTIT, français, 4 min 38 

o http://sertit.unistra.fr/  

o A 2 min 10 : présentation du service de cartographie rapide/de crise 

 Navigateur des cartes des crises les plus récentes 

o http://sertit.unistra.fr/cartographie-rapide/  

8.2 Exemples supplémentaires par outils ou 

thématique 

Google Earth Engine (GEE) 

 Google Earth Engine (GEE) 

o https://earthengine.google.com/  

o Plateforme pour faire tourner des géo-algorithme à l’échelle mondiale en 

utilisant les ressources de Google et qui donne accès à de très grandes bases de 

données d’images satellites à l’échelle mondiale. 

 Google Earth Engine (GEE) Timelapse  

o Timelapse 1984-année actuelle moins 1, série d’exemples d’évolution temporelle 

de la surface terrestre suite à diverses actions anthropiques mise en évidence 

http://sertit.unistra.fr/
http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-permet-d-aider-a-la-gestion-des
http://fr.euronews.com/2016/06/03/copernicus-ou-quand-l-imagerie-satellite-permet-d-aider-a-la-gestion-des
http://sertit.unistra.fr/
http://sertit.unistra.fr/cartographie-rapide/
https://earthengine.google.com/
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o https://earthengine.google.com/timelapse/   

o Vidéo 2 min 

o https://www.youtube.com/watch?v=kIYHGkSb-fU  

o Cas d’études 

o https://earthengine.google.com/case_studies/  

o Global Forest Cover Change 

o Malaria Risk Mapping 

Google Earth: exemples d’images de catastrophes naturelles visualisables dans GOOGLE 

EARTH 

Certains sites web mettent à disposition des fichiers dont l’extension est « .KMZ » ou 

« .KML », formats qui permettent la visualisation de ces données dans GOOGLE EARTH 

facilement et rapidement sans devoir télécharger l’image brute. Voici quelques exemples : 

 Inondation 

o Australian city of Rockhampton, 2011 

o Capteur : Advanced Spaceborne Thermal Emission and Reflection Radiometer 

(ASTER) on NASA’s Terra   

o http://earthobservatory.nasa.gov/IOTD/view.php?id=48456&src=eorss-iotd 

o Cliquer sur “Google Earth file (KML)” 

 Typhon 

o http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-

disasters-improving.html  

o Hurricane Matthews, 2016, widespread devastation, crossing over Haiti, the 

Bahamas and then up the east coast of the United States. 

o Cliquer sur: “You can see the satellite imagery in Google Earth with this KML file

 from Google Crisis Response” 

o Dans Google Earth : cocher uniquement : « Hurrican Matthews 2016 > Haiti > 

Digital Globa imagery > Les Irois, Haiti » 

 Tremblement de terre 

o http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-

kumamoto-google-earth-3d.html  

o Large earthquakes in the City of Kumamoto, Japan, 2016 

o Images acquises après le séisme: visualisation des destructions 

o Google Earth tour of the area showing all the light blue roofs, which you can view 

in Google Earth with this KML file  or see in the YouTube vidéo below. 

https://earthengine.google.com/timelapse/
https://www.youtube.com/watch?v=kIYHGkSb-fU
https://earthengine.google.com/case_studies/
http://asterweb.jpl.nasa.gov/
http://terra.nasa.gov/
http://earthobservatory.nasa.gov/IOTD/view.php?id=48456&src=eorss-iotd
http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-disasters-improving.html
http://www.gearthblog.com/blog/archives/2016/10/acquisition-imagery-natural-disasters-improving.html
http://mw1.google.com/crisisresponse/2016/hurricane_matthew/2016-hurricane-matthew-updated-imagery_nl.kml
http://mw1.google.com/crisisresponse/2016/hurricane_matthew/2016-hurricane-matthew-updated-imagery_nl.kml
http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-kumamoto-google-earth-3d.html
http://www.gearthblog.com/blog/archives/2016/09/post-earthquake-kumamoto-google-earth-3d.html
http://www.gearthblog.com/wp-content/uploads/2016/09/Kumamoto-in-3D.kmz
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Déforestation 

 Déforestation en Amazonie, Timelapse 

o https://www.youtube.com/watch?v=oBIA0lqfcN4  

 Pattern de déforestation en Amazonie, en détails 

o Visualisation dans Google Earth Pro des motifs de déforestation au Brésil, 
Indonésie, etc 

 Déforestation au Brésil, Etat du Rondonia, en détails, vidéo haute qualité (30 ‘’)  

o https://www.youtube.com/watch?v=JsIB81sLe2w  

 Déforestation à Haïti, vidéo 

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=2640&button=popular  

 Autre courtes vidéos sur différents endroits déforestés entre 2000 et 2012, avec 

LANDSAT 

o https://www.youtube.com/channel/UCGnX8ABNZYuZrhzT-sJVaeg  

 Monitoring Forests From the Ground to the Cloud , vidéo 5 min, Système d’alerte de 

déforestation via Google Earth Engine, exemples internationaux,  

o https://www.youtube.com/watch?v=ymKHb3WJLz4  

 Déforestation en Papouasie-Nouvelle-Guinée (2 images géotiff) 

o http://earthobservatory.nasa.gov/IOTD/view.php?id=8810  

 Déforestation au Brésil (2 images géotiff) 

o http://earthobservatory.nasa.gov/IOTD/view.php?id=6811  

Mine 

 Appalachian Mountaintop Removal in Google Earth & Maps (vidéo en anglais, 5 min) 

 https://www.youtube.com/watch?v=aiSzOiGFa-0  

 Visible également dans GOOGLE EARTH PRO Desktop > Menu sensibilisation 

mondiale > extraction minière à ciel ouvert dans les Appalaches  

Masse d’eau 

 Mer d’Aral: Drying of the Aral Sea: Timelapse , vidéo 2 min 

o https://www.youtube.com/watch?v=cbSkRS8Ih7o  

 Lac Chad: UNEP & Google Earth highlights environmental change, vidéo 1 minute 

o https://www.youtube.com/watch?v=JXW29zsr6xg  

Inondation 

https://www.youtube.com/watch?v=oBIA0lqfcN4
https://www.youtube.com/watch?v=JsIB81sLe2w
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=2640&button=popular
https://www.youtube.com/channel/UCGnX8ABNZYuZrhzT-sJVaeg
https://www.youtube.com/watch?v=ymKHb3WJLz4
http://earthobservatory.nasa.gov/IOTD/view.php?id=8810
http://earthobservatory.nasa.gov/IOTD/view.php?id=6811
https://www.youtube.com/watch?v=aiSzOiGFa-0
https://www.youtube.com/watch?v=cbSkRS8Ih7o
https://www.youtube.com/watch?v=JXW29zsr6xg
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 Centre royale de télédétection du Royaume du Maroc, cartographie rapide en cas 

d’inondations 

o http://www.crts.gov.ma/thematiques/risques-naturels/inondations  

 Télédétection et gestion des catastrophes naturelles : application à l’étude des 

inondations urbaines de Saint-Louis et du ravinement lié à l’érosion hydrique à Nioro-

Du-Rip (Sénégal)  

o https://hal.archives-ouvertes.fr/hal-00434297/document 

Glaces et fontes des glaces 

 Annual Arctic Sea Ice Minimum 1979-2015 with Area Graph, vidéo  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4435&button=popular  

 Weekly Animation of Arctic Sea Ice Age with Graph of Ice Age by Percent of Total: 

1984 – 2016, vidéo + textes:  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4509&button=popular  

 Fonte des glaces en Arctique : vidéo de Greenpeace 

o https://www.facebook.com/greenpeace.belgium/vidéos/10154505188555239/ 

 Epaisseur de glace par Radar : Icesat-2 Measurements Over Antarctica (prelaunch), 

vidéo 2 min,  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4492&button=recent  

Feux 

 https://earthdata.nasa.gov/earth-observation-data/near-real-time/firms 

Température du globe 

 Five-Year Global Temperature Anomalies from 1880 to 2015, vidéo,  

o http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4419&button=popular  

Urbanisation 

 Las Vegas Urban Expansion: Timelapse , vidéo 3 minutes,  

o https://www.youtube.com/watch?v=cPRGfyd93fo  

Tsunami 

 Cartes satellites des zones sinistrées au Japon, vidéo, français, 1 minute,  

http://www.crts.gov.ma/thematiques/risques-naturels/inondations
https://hal.archives-ouvertes.fr/hal-00434297/document
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4435&button=popular
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4509&button=popular
https://www.facebook.com/greenpeace.belgium/videos/10154505188555239/
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4492&button=recent
https://earthdata.nasa.gov/earth-observation-data/near-real-time/firms
http://svs.gsfc.nasa.gov/cgi-bin/details.cgi?aid=4419&button=popular
https://www.youtube.com/watch?v=cPRGfyd93fo
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o https://www.youtube.com/watch?v=XJVF1TNnLZY 

o Les scientifiques du Service régional de traitement d'image et de télédétection 

(SERTIT) de Strasbourg aident les sinistrés japonais. Ils élaborent de précieuses 

cartes à l'aide de satellites français pour permettent aux secouristes de se 

déplacer dans les zones dévastées.  

Littoral 

 La télédétection pour surveiller le littoral, vidéo français 3 minutes, drones,  

o https://www.youtube.com/watch?v=SNLyd_FAYOg  

Marée noire 

 NASA, Satellites View Growing Gulf Oil Spill,  

o https://www.youtube.com/watch?v=mCWW5xt3Hc8  

 NASA Aids Nation's Response to Oil Spill with Aircraft, Satellites,  

o https://www.youtube.com/watch?v=f5qh13Xp-_0  

Volcan 

 Monitoring Volcanoes Using ASTER Satellite Imagery, vidéo, English, 5 min,  

o https://www.youtube.com/watch?v=A39FnHdSoNk  

Sécurité alimentaire 

 http://www.fews.net/fr 

Avertissements précoces 

 Suivi des conditions de végétation, précipitations, climat, niveau des étendues d’eau, 

etc dans l’optique de déclencher des avertissements vers les autorités d’un pays, 

d’une région en cas de problème/crise 

o https://earlywarning.usgs.gov/fews 

Refugiés 

 Story Map about Rohingya refugees (by the The UN Refugee Agency (UNHCR)) 

o https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-

gallery/2018-winners  

Divers 

https://www.youtube.com/watch?v=XJVF1TNnLZY
https://www.youtube.com/watch?v=SNLyd_FAYOg
https://www.youtube.com/watch?v=mCWW5xt3Hc8
https://www.youtube.com/watch?v=f5qh13Xp-_0
https://www.youtube.com/watch?v=A39FnHdSoNk
http://www.fews.net/fr
https://earlywarning.usgs.gov/fews
https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-gallery/2018-winners
https://www.esri.com/en-us/arcgis/products/esri-story-maps/contest/winners-gallery/2018-winners
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 ENVI, Les images satellites pour la gestion des catastrophes naturelles, vidéo 

français,  

o https://www.youtube.com/watch?v=Tp2hIeeSVXE  

 La télédétection appliquée aux catastrophes naturelles : Faits et chiffres 

o https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-

fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html 

 MapGive 

o https://mapgive.state.gov/   

o Volunteers like you can help trace roads, buildings, and houses using 

OpenStreetMap that will aid in humanitarian missions. 

 Nombreux exemples d’analyse diachroniques à partir d’images satellites, classés par 

thèmes, lieux, dates. 

o http://earthobservatory.nasa.gov/Images/?eocn=topnav&eoci=images 

 Systèmes d’analyse des risques par télédétection spatiale   

o https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Tel

edetection_spatiale/Teledetection_spatiale.html 

 Liste de données SIG sur des catastrophes naturelles.  

o https://freegisdata.rtwilson.com/#natural-disasters  

 

https://www.youtube.com/watch?v=Tp2hIeeSVXE
https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html
https://www.scidev.net/afrique-sub-saharienne/sciences-de-la-terre/article-de-fond/la-t-l-d-tection-appliqu-e-aux-catastrophes-naturelles-faits-et-chiffres.html
https://mapgive.state.gov/
http://earthobservatory.nasa.gov/Images/?eocn=topnav&eoci=images
https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Teledetection_spatiale/Teledetection_spatiale.html
https://ressources.uved.fr/Grains_Module3/Teledetection_spatiale/site/html/Teledetection_spatiale/Teledetection_spatiale.html
https://freegisdata.rtwilson.com/#natural-disasters
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9 Quelques logiciels de télédétection spatiale 

Nom Prix Site web 
 

Télédétection   
SNAP Gratuit https://step.esa.int/main/toolboxes/snap/ 

Logiciel de l’ESA pour les images « Sentinel » et + 
ENVI Payant http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx 
IDRISI Payant http://www.clarklabs.org/products/idrisi.cfm  
ERDAS 
 

Payant http://geospatial.intergraph.com/products/ERDAS-
IMAGINE/Details.aspx  

QGIS 
 

Gratuit http://www.qgis.org/fr/site/  
Via des extensions de Quantum GIS : GDAL/OGR, GRASS, SAGA, etc. 

R Gratuit http://www.r-project.org/ 
Via des packages dédiés aux rasters : raster, rgdal, maptools, etc 
 

RSTUDIO Gratuit https://rstudio.com/  
Interface pratique pour utiliser R 

Google Earth 
Engine (GEE) 

Gratuit https://earthengine.google.org/  
Application cloud puissante idéale pour travailler sur de très 
grandes quantités de données 

SIG   
ArcGIS Payant http://www.arcgis.com/features/  
QGIS 
 

Gratuit http://www.qgis.org/fr/site/  

 
Pour travailler sur des séries temporelles d’images basse-résolution 
TIMESAT Gratuit http://www.nateko.lu.se/TIMESAT/timesat.asp  
SPIRITS Gratuit https://rs.vito.be/africa/en/software/Pages/Spirits.aspx  
VGT EXTRACT 
 

Gratuit http://www.devcocast.eu/VGTExtract.do  

 
Pour travailler sur des données hyperspectrales ponctuelles 
ViewSpec Pro Gratuit http://support.asdi.com/Products/Products.aspx  
 
 
 

https://step.esa.int/main/toolboxes/snap/
http://www.exelisvis.com/ProductsServices/ENVI/ENVI.aspx
http://www.clarklabs.org/products/idrisi.cfm
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://geospatial.intergraph.com/products/ERDAS-IMAGINE/Details.aspx
http://www.qgis.org/fr/site/
http://www.r-project.org/
https://rstudio.com/
https://earthengine.google.org/
http://www.arcgis.com/features/
http://www.qgis.org/fr/site/
http://www.nateko.lu.se/TIMESAT/timesat.asp
https://rs.vito.be/africa/en/software/Pages/Spirits.aspx
http://www.devcocast.eu/VGTExtract.do
http://support.asdi.com/Products/Products.aspx
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Annexe 1 - Les différents types de résolution des images satellites 
 
 

1. Résolution spatiale 
 

 Mesure de la plus petite séparation angulaire ou linéaire entre deux objets, 

habituellement exprimée en radians ou en mètres. 

 Correspond à la longueur des côtés des pixels de l’image 

 
 

2. Résolution temporelle (d’une série temporelle d’images ou d’un capteur) 

 
 Fréquence à laquelle les images d’un endroit donné sont acquises par un capteur 

 

 
Série temporelle de 36 images NDVI décadaires (36 images * 10 jours = 360 jours = 1 an) de type 
SPOT VEGETATION pour le Pakistan et évolution temporelle du NDVI en un pixel présentant une 
alternance marquée de l’état de la végétation selon les saisons. La résolution temporelle de cette 
série est de « 1 image / 10 jours ». 

 

 
 

   
30 mètres (Landsat)      15 mètres (Aster)   10 mètres (SPOT 5)     250 mètres (MODIS) 
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3. Résolution spectrale 
 

 Aptitude d'un système de détection à distinguer des rayonnements 

électromagnétiques de fréquences (ou longueurs d’onde) différentes. 

 La résolution spectrale d’un capteur décrit les fenêtres (gammes) de longueurs 

d’ondes qu’il est capable d’enregistrer. La taille et le nombre de ces fenêtres 

définissent la résolution spectrale d’un capteur. Plus la résolution spectrale est fine, 

plus les fenêtres des différents canaux du capteur sont étroites 

 

 
 
 
 
 
 

 
 

4. Résolution radiométrique 
 

 La résolution radiométrique d'un système de télédétection décrit sa capacité à 

reconnaître de petites différences dans l'énergie électromagnétique. Plus la 

résolution radiométrique d'un capteur est fine, plus le capteur est sensible à de 

petites différences dans l'intensité de l'énergie reçue.  

 La résolution radiométrique est définie par le nombre maximum de niveaux 

d'intensité d'énergie électromagnétique que le capteur peut enregistrer et dépend 

du nombre de bits utilisés pour représenter l'intensité enregistrée, par exemple : 

    

« Cube hyperspectrale », issu d’un capteur 
hyperspectral (à très haute résolution spectrale). 
Par exemple : 2150 bandes spectrales de 1 nm 
de large chacune. 

Résolution spectrale du capteur SPOT 4, composé de 4 
bandes de largeurs comprises entre 70 et 170µm : 

 B1 : 0,50 à 0,59 mm (90 µm) 

 B2 : 0,61 à 0,68 mm (70 µm) 

 B3 : 0,78 à 0,89 mm (110 µm) 

 MIR : 1,58 à 1,75 mm (170 µm) 
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o Si 8 bit sont utilisés, 28 soit 256 valeurs numériques allant de 0 à 255 sont 

disponibles 

o Si 4 bits sont utilisés, 24 soit 16 valeurs numériques allant de 0 à 15 sont 

disponibles 

 En pratique, la résolution radiométrique détermine le niveau de détail discernable 

sur les images. 

 

 
 

 
 
Sources d’inspiration : 

 Centre canadien de télédétection : http://cct.rncan.gc.ca/index_f.php 

 International Training in Yield forecasting, Introduction to remote sensing for 

agriculture applications, Pr. Pierre Defourny (UCL - Geomatics) 

 
 

 
2 bit 

 
8 bit 

  
4 bit      8 bit 

http://cct.rncan.gc.ca/index_f.php
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Annexe 2 - Exemple de matrice de confusion et de son interprétation 
 
Considérons une image satellite couvrant une zone d’étude caractérisée par 3 types 

d’occupation du sol à identifier par classification: 

 Eau (rivière, étang) 

 Prairie 

 Forêt 

L’image est classifiée et des zones de validation (ou « Ground truth Region Of Interest ») 

sont créées pour chacune des classes d’occupation du sol (Figure 1). Ces zones 

correspondent à des régions pour lesquelles l’occupation du sol est connue avec certitude, 

soit via photo-interprétation, soit via enquête de terrain avec relevés GPS par exemple. La 

précision de la classification de l’ensemble de l’image est ensuite évaluée  en comparant, 

dans ces zones de validation, l’occupation du sol réelle (définie par l’opérateur) avec celle 

identifiée par le processus de classification. 

 
Figure 28 : Image classifiée de la zone d’étude. Les encadrés noirs correspondent aux zones de 

validation ou « Ground truth Region Of Interest ». Les classes auxquelles sont assignées chacune 
de ces zones de validation sont mentionnées au-dessus des encadrés. 
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La matrice de confusion (ou « tableau de contingence ») permet d’évaluer la précision de la 

classification (de manière globale et pour chacune des classes). Elle est calculée à partir des 

pixels correctement/incorrectement classifiés dans les zones de validation mais est sensée 

être représentative de la précision de la classification de l’ensemble de l’image. D’où 

l’importance de créer suffisamment de zones de validation, correctement réparties sur 

l’ensemble de l’image, et reprenant l’ensemble des réalités spectrales de chacune des 

classes de l’image (exemple : créer des zones de validation de la classe forêt dans les 

différents massifs forestiers de l’image qui présentent probablement de petites nuances 

spectrales (variation de l’exposition, des essences, de l’ensoleillement, etc). 

Les zones utilisées pour la validation sont : 

 2 zones de validation pour la classe « Eau », composées de 17 pixels au total 

 4 zones de validation pour la classe « Prairie », composées de 33 pixels au total 

 4 zones de validation pour la classe « Forêt », composées de 30 pixels au total 

La matrice de confusion associée à cette classification est reprise en Figure 29. 

 Zones de validation 

C
la

ss
if

ic
at

io
n

 

 Eau Prairie Forêt Total 
Erreurs de 

commission 
Précision 

d’utilisation 

Eau 17 0 1 18 1/18   (6%) 17/18 (94%) 

Prairie 0 27 3 30 3/30  (10%) 27/30 (90%) 

Forêt 0 6 26 32 6/32  (19%) 26/32 (81%) 

Total 17 33 30 80   

Erreurs 
d’omission 

0/17 
(0%) 

6/33 
(18%) 

4/30 
(13%) 

 
Erreur globale : 
10/80 (12,5%) 

 

Précision de 
production 

17/17 
(100%) 

27/33 
(82%) 

26/30 
(87%) 

  
Précision globale :  

70/80 (87,5%) 
Figure 29 : Matrice de confusion associée à la classification de l’image satellite. 

 
La structure (dans cet exemple-ci) de la matrice de confusion est la suivante : 

 Une colonne de la matrice fait référence aux zones de validation de la classe 

identifiée par cette colonne et permet de calculer l’erreur d’omission de cette classe 

 Une ligne de la matrice fait référence aux pixels classifiés dans la classe identifiée par 

cette ligne (dans les zones de validation de l’ensemble des classes) et permet de 

calculer l’erreur de commission de cette classe 

 La diagonale de la matrice de confusion représente tous les pixels correctement 

classifiés : pixels déclarés (par la création des zones de validation) comme 

appartenant à une classe et classifiés par le logiciel dans cette classe 

 La somme des totaux par lignes ou par colonnes correspondent à la somme des pixels 

de l’ensemble des zones de validation de l’ensemble des classes. 
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Les erreurs d’omission : 
L’erreur d’omission d’une classe donnée est calculée en divisant le nombre total de pixels 
incorrectement classifiés dans les zones de validation de cette classe (« omis » de la classe 
étudiée) par le nombre total de pixels des zones de validation de cette classe. Dans la 
matrice de confusion, ce calcul s’effectue sur base de la colonne correspondant à la classe 
étudiée. 

 « Eau » : 0 pixel n’ont été mal classifiés sur les 17 pixels des zones de validation de la 

classe « Eau », soit 0/17 = 0% d’erreur d’omission (0% des pixels des zones de 

validation de la classe « Eau » n’ont été omis de la classe « Eau ») 

 « Prairie » : 6 pixel ont été mal classifiés (dans la classe « Forêt ») sur les 33 pixels des 

zones de validation de la classe « Prairie », soit 6/33 = 18% d’erreur d’omission (18% 

des pixels des zones de validation de la classe « Prairie » ont été omis de la classe 

« Prairie » (et classifié dans la classe « Forêt ») alors qu’ils auraient du être classifiés 

dans la classe « Prairie ») 

 « Forêt » : 4 pixel ont été mal classifiés (dans les classes « Eau » et « Prairie») sur les 

30 pixels des zones de validation de la classe « Forêt », soit 4/30 = 13% d’erreur 

d’omission (13% des pixels des zones de validation de la classe « Forêt » ont été omis 

de la classe « Forêt » (et classifié dans les classes « Eau » et « Prairie») alors qu’ils 

auraient du être classifiés dans la classe « Forêt ») 

 
Les précisions de production : 
La précision de production d’une classe donnée est calculée en divisant le nombre total de 
pixels correctement classifiés dans les zones de validation de cette classe par le nombre 
total de pixels des zones de validation de cette classe. Elle est égale à (1-l’erreur d’omission). 
 
La précision de production mesure la probabilité que le processus de classification ait 
classifié un pixel se trouvant dans une zone de validation d’une certaine classe dans cette 
classe. 

Autrement dit : 
Probabilité qu’un pixel qui appartient réellement (dans le monde réel) à une classe « a » ait 
été classifié dans cette classe « a ».  

Autrement dit : 
« En tant que producteur d’une classification (celui qui réalise la classification), je me 
demande, pour un pixel appartenant réellement à la classe « a » (dans le monde réel), quelle 
est la probabilité qu’il ait été classifié dans la classe « a » ? » 
 
Les erreurs de commission : 
L’erreur de commission  d’une classe donnée est calculée en divisant le nombre total de 
pixels incorrectement classifiés dans cette classe dans les zones de validation des autres 
classes (erreur « commise dans les autres classes ») par le nombre total de pixels classifiés 
dans cette classe sur l’ensemble des zones de validation de l’ensemble des classes. Dans la 
matrice de confusion, ce calcul s’effectue sur base de la ligne correspondant à la classe 
étudiée. 



 95 

 « Eau » : 1 pixel a été mal classifié (en tant que « Eau ») alors qu’il appartient (d’après 

les zones de validation) à d’autres classes (ici, la classe « Forêt »), sur un total de 18 

pixels classifiés dans la classe « Eau » dans l’ensemble des zones de validation de 

l’ensemble des classes, soit 1/18 = 6% d’erreur de commission (6% des pixels 

classifiés dans la classe « Eau » appartiennent en réalité à d’autres classes (ici la 

classe « Forêt») 

 « Prairie » : 3 pixels ont été mal classifiés (en tant que « Prairie ») alors qu’ils 

appartiennent (d’après les zones de validation) à d’autres classes (ici, la classe 

« Forêt »), sur un total de 30 pixels classifiés dans la classe « Prairie » dans l’ensemble 

des zones de validation de l’ensemble des classes, soit 3/30 = 10% d’erreur de 

commission (10% des pixels classifiés dans la classe « Prairie » appartiennent en 

réalité à d’autres classes (ici la classe « Forêt») 

 « Forêt » : 6 pixels ont été mal classifiés (en tant que « Forêt ») alors qu’il 

appartiennent (d’après les zones de validation) à d’autres classes (ici, la classe 

« Prairie »), sur un total de 32 pixels classifiés dans la classe « Forêt » dans l’ensemble 

des zones de validation de l’ensemble des classes, soit 6/32 = 19% d’erreur de 

commission (19% des pixels classifiés dans la classe « Forêt » appartiennent en réalité 

à d’autres classes (ici la classe « Prairie») 

 
Les précisions d’utilisation : 
La précision d’utilisation d’une classe donnée est calculée en divisant le nombre total de 
pixels correctement classifiés dans cette classe dans l’ensemble des zones de validation de 
cette classe par le nombre total de pixels classifiés dans cette classe dans l’ensemble des 
zones de validation de l’ensemble des classes. Elle est égale à (1-l’erreur de commission). 
 
La précision d’utilisation mesure la probabilité qu’un pixel appartienne réellement à une 
certaine classe lorsque le processus de classification a classifié ce pixel dans cette classe. 

Autrement dit : 
Probabilité qu’un pixel qui a été classifié dans une classe « a » appartienne réellement (dans 
le monde réel) à cette classe « a ». 

Autrement dit : 
« En tant qu’utilisateur d’une classification (celui qui lit/utilise la classification), je me 
demande, pour un pixel classifié dans une classe « a », quelle est la probabilité qu‘il 
appartienne réellement (dans le monde réel)  à la classe « a ». » 
 
Erreur globale de la classification : 
L’erreur globale de la classification est calculée en divisant le nombre de pixels mal classifiés 
dans l’ensemble des zones de validations de l’ensemble des classes par le nombre de pixels 
de l’ensemble des zones de validation de l’ensemble des classes. L’erreur globale = (1-la 
précision globale). 

o Erreur globale : 10 pixels mal classifiés dans l’ensemble des zones de validation de 
l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones de validation 
de l’ensemble des classes = 12.5 % d’erreur globale. 
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Précision globale de la classification : 
La précision globale de la classification est calculée en divisant le nombre de pixels 
correctement classifiés dans l’ensemble des zones de validation de l’ensemble des classes 
par l’ensemble des pixels de l’ensemble des zones de validation de l’ensemble des classes. 

 Précision globale : 70 pixels correctement classifiés dans l’ensemble des zones de 

validations de l’ensemble des classes divisé par les 80 pixels de l’ensemble des zones 

de validation de l’ensemble des classes = 87.5 % de précision globale. La précision 

globale = (1- l’erreur globale) 

 
Plus d’infos sur les matrices de confusion : Centre Canadien de télédétection 
http://cct.rncan.gc.ca/glossary/index_f.php?id=3124 

 

http://cct.rncan.gc.ca/glossary/index_f.php?id=3124
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Annexe 3 - Matrice de confusion dans ENVI 
Source : ENVI HELP4.4. 

 
Une matrice de confusion permet de mesurer la précision d’un résultat de classification en 
comparant un résultat de classification avec la « vérité terrain ». Cette vérité terrain peut se 
présenter sous la forme de « région d’intérêt – vérité terrain» ou d’une « image-vérité-
terrain ». 
 
Exemple de matrice de confusion. 
 

 Confusion Matrix: {M6} (640x400x1)  

 Overall Accuracy = (131003/256000) 51.1730%  

 Kappa Coefficient = 0.2648  

 
Ground Truth (Pixels) 

Class Unclassified Grass Forest Swamp Total 

Unclassified 43689 26949 40 18001 88679 

Grass 32835 64516 1741 3329 102421 

Forest 8202 7277 4096 654 20229 

Swamp 15227 10742 0 18702 44671 

Total 99953 109484 5877 40686 256000 

 
Ground Truth (Percent) 

Class Unclassified Grass Forest Swamp Total 

Unclassified 43.71 24.61 0.68 44.24 36.64 

Grass 32.85 58.93 29.62 8.18 40.01 

Forest 8.21 6.65 69.70 1.61 7.90 

Swamp 15.23 9.81 0 45.97 17.45 

Total 100 100 100 100 100 

 
Commission and Omission Error 

Class 
Commission 

Percent 
Omission 
Percent 

Commission 
Pixels 

Omission 
Pixels 

Unclassified 50.73 56.29 44990/88679 56264/99953 

Grass 37.01 41.07 37905/102421 44968/109484 

Forest 79.75 30.30 16133/20229 1781/5877 

Swamp 58.13 54.03 25969/44671 21984/40686 

 
Producer and User Accuracy 

Class 
Prod. Acc. 

Percent 
User Acc. 
Percent 

Prod. Acc. 
Pixels 

User Acc. 
Pixels 

Unclassified 43.71 49.27 43689/99953 43689/88679 

Grass 58.93 62.99 64516/109484 64516/102421 

Forest 69.70 20.25 4096/5877 4096/20229 

Swamp 45.97 41.87 18702/40686 18702/44671 
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Overall Accuracy  
The overall accuracy is calculated by summing the number of pixels classified correctly and 
dividing by the total number of pixels. The ground truth image or ground truth ROIs define 
the true class of the pixels. The pixels classified correctly are found along the diagonal of the 
confusion matrix table which lists the number of pixels that were classified into the correct 
ground truth class. The total number of pixels is the sum of all the pixels in all the ground 
truth classes.  
 
Kappa Coefficient  
The kappa coefficient (k) is another measure of the accuracy of the classification.  

 
Confusion Matrix (Pixels)  
The confusion matrix is calculated by comparing the location and class of each ground truth 
pixel with the corresponding location and class in the classification image. Each column of 
the confusion matrix represents a ground truth class and the values in the column 
correspond to the classification image's labeling of the ground truth pixels. For example, 
look at the ground truth column for the Forest class in the Ground Truth (Pixels) table above. 
The ground truth shows 5,877 pixels in this class. The classification was able to classify 4,096 
of these pixels properly but 40 pixels were Unclassified and 1,741 were classified as Grass.  
 
Confusion Matrix (Percent)  
The Ground Truth (Percent) table shows the class distribution in percent for each ground 
truth class. The values are calculated by dividing the pixel counts in each ground truth 
column by the total number of pixels in a given ground truth class. For example, in the Forest 
class the percent pixels classified correctly is 4,096/5,877=0.697 or 69.7%.  
 
Errors of Commission  
Errors of commission represent pixels that belong to another class that are labelled as 
belonging to the class of interest. The errors of commission are shown in the rows of the 
confusion matrix. In the confusion matrix example, the Grass class has a total of 102,421 
pixels where 64,516 pixels are classified correctly and 37,905 other pixels are classified 
incorrectly as Grass (37,905 is the sum of all the other classes in the Grass row of the 
confusion matrix). The ratio of the number of pixels classified incorrectly by the total 
number of pixels in the ground truth class forms an error of commission. For the Grass class 
the error of commission is 37,905/102,421 which equals 37%.  
 
Errors of Omission  
Errors of omission represent pixels that belong to the ground truth class but the 
classification technique has failed to classify them into the proper class. The errors of 
omission are shown in the columns of the confusion matrix. In the confusion matrix 
example, the Grass class has a total of 109,484 ground truth pixels where 64,516 pixels are 
classified correctly and 44,968 Grass ground truth pixels are classified incorrectly (44,968 is 
the sum of all the other classes in the Grass column of the confusion matrix). The ratio of the 
number of pixels classified incorrectly by the total number of pixels in the ground truth class 
forms an error of omission. For the Grass class the error of omission is 44,968/109,484 which 
equals 41.1%.  
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Producer Accuracy  
The producer accuracy is a measure indicating the probability that the classifier has labelled 
an image pixel into Class A given that the ground truth is Class A. In the confusion matrix 
example, the Grass class has a total of 109,484 ground truth pixels where 64,516 pixels are 
classified correctly. The producer accuracy is the ratio 64,516/109,484 or 58.9%.  
 
User Accuracy  
User accuracy is a measure indicating the probability that a pixel is Class A given that the 
classifier has labelled the pixel into Class A. In the confusion matrix example, the classifier 
has labelled 102,421 pixels as the Grass class and a total of 64,516 pixels are classified 
correctly. The user accuracy is the ratio 64,516/102,421 or 63.0%. 
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Annexe 4 - Traduction des commentaires de la vidéo HOLOGLOBE_v3 
 
Source : http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/  
Durée : 6 minutes 19 secondes 

 
La terre dans l’espace : 

 9 planètes en orbite autour du soleil 

 3ème planète est la terre 

 Vénus et Mars sont les planètes les plus proches et les plus similaires par rapport à la 

terre.  

 
Mais Vénus et Mars sont très différentes de la terre.  

 Vénus est la plus similaire à la terre point de vue taille, masse et gravité mais a une 

atmosphère dense en CO2 et n’a pratiquement pas d’eau avec une surface très 

chaude (+/- 800°F) = 400°C. (°C = (°F - 32) / 1,8) 

 Mars : moitié de la taille de la terre et une atmosphère mince. Surface est froide (-

190°F) = -123°C et l’eau est gelée à ces pôles et probablement en dessous de sa 

surface. 

 
Notre terre est unique : 

 70% de la surface terrestre est couverte par de l’eau liquide 

 L’atmosphère est riche en vapeur d’eau 

 Planète géologiquement active 

 Caractéristique principale : présence et diversité de la VIE sur terre ! 

 
Les navettes spatiales et les satellites qui enregistrent des images de la terre changent 
notre vision de la terre. 
 
Nous voyons maintenant les océans, les surfaces terrestres, l’atmosphère, la vie, le tout 
interconnecté dans un système mondial. La terre est baignée dans l’énergie solaire. Les 
océans, surfaces terrestres et atmosphères absorbent et sont réchauffés par l’énergie 
solaire. La chaleur absorbée par les océans et transportée par les courants marins est 
continuellement libérée vers l’atmosphère. La chaleur et l’humidité libérées par les océans 
dirigent la circulation atmosphérique et le climat. L’humidité dans l’atmosphère forme les 
nuages qui couvrent en moyenne 40% de la surface terrestre à tout moment donné. 
 
“The pattern in cloud motion in this time lapse sequence shows how earth's winds, moving 
bands or zones, which define regional winds directions” (difficile à comprendre et traduire). 
 
Le mouvement de l’humidité ou de la vapeur d’eau dans l’atmosphère jouent un rôle 
important dans la détermination du climat. Dans cette animation des mouvements des 
vapeurs d’eau de l’atmosphère, les ouragans de 1995 sont visibles. Les ouragans se forment 

http://svs.gsfc.nasa.gov/vis/a000000/a000100/a000155/
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au large des côtes africaines (2m32) et se déplacent à l’ouest à travers l’Océan Atlantique 
vers les Caraïbes et la côte est des USA. 
 
Le climat mondial est également influencé par la manière dont la chaleur est répartie par les 
océans. Sont montés ici les changements de températures de surface des océans sur une 
période de 9 ans. Les surfaces d’eau les plus chaudes sont indiquées en rouge, les plus 
froides en bleu. Avec ce genre de données, il est possible de détecter l’augmentation 
anormale de température qui arrive lorsque les eaux froides en temps normal de l’est de 
l’Océan Pacifique sont remplacées par des eaux plus chaudes. Ce phénomène est connu sous 
le nom d’El Nino. El Nino pourrait perturber le climat à une échelle mondiale causant de 
vastes inondations et sécheresses. 
 
Drainant les océans […], il y a la surface solide de la terre avec la croute terrestre qui est 
divisée en « Hautes terres » et « Basses terres » 

 Les Hautes terres sont les terres émergées qui forment les continents 

 Les Basses terres forment les bassins océaniques. 

La croute terrestre n’est pas une coquille fixe et continue. Elle est brisée en une mosaïque 
de plaques mouvantes. Au fur et à mesure que ces plaques bougent et se frottent les unes 
aux autres, elles libèrent d’énormes quantités d’énergie sous la forme de tremblements de 
terre. Les points jaunes montrent la localisation des tremblements de terre qui ont eu lieu 
entre 1980 et 1995 avec une magnitude supérieure à 4.5 sur l’échelle de Richter. Ces 
tremblements de terre indiquent clairement les limites des plaques de la croute terrestre.  
 
Lorsque les plaques océaniques s’entrechoquent avec les plaques terrestres […] cela forme 
les volcans. Les triangles rouges indiquent les éruptions volcaniques enregistrées qui se sont 
passées entre 1960 et 1995. Comme pour les tremblements de terre, la plupart des volcans 
sont localisés le long des limites des plaques terrestres. 
 
Les océans, l’atmosphère et les continents jouent tous un rôle critique pour le maintient de 
la vie durable sur terre. Les caractéristiques des courants marins, des vents, et de la 
topographie peuvent faire d’une région un désert et d’une autre une région verte […]. Les 
changements de saisons affectent grandement la végétation terrestre. Les couleurs vertes 
et jaunes montrent comment les plantes grandissent et dépérissent au cours des saisons 
d’une année. Les vastes déserts du nord de l’Afrique, de la péninsule arabique et de l’Asie 
centrale sont facilement reconnaissables à cause de l’absence de végétation. 
 
L’influence des hommes sur la terre peut également être vue depuis l’espace. Une vision de 
la terre pendant la nuit permet de voir les lumières des campements, villages et villes qui 
sont éclairés. Les endroits fortement peuplés apparaissent en blanc. Les incendies et 
l’agriculture sur brulis (slash and burn) et la combustion de gaz dans les champs de pétroles 
sont montrés en rouge et jaune. Depuis ce point de vue, l’importance de l’activité humaine 
sur la planète peut être évaluée. L’entièreté du globe est concernée. 
 
Un suivi global de la terre nous aide à comprendre les interactions complexes entre les 
atmosphères, les océans et les terres ainsi que leurs impacts sur la vie. Seule une vue 
mondiale nous permet d’apprécier notre terre en tant que planète. 
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Annexe 5 - Illustrations supplémentaires 
 

 

 
Figure 30 : Evolution temporelle du NDVI pour un pixel du Nord Pakistan  sur une image SPOT 

Végétation dans le logiciel Windisp (logiciel obsolète) 

 

 

 

Figure 31 : Principe de la conversion des DN (Digital Numbers) en valeurs NDVI grâce aux 
coefficient a (pente) et b (intercepte) présents dans le fichier entête (header file) de certaines 

images
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Annexe 6 - Wavelength in electromagnetic spectrum 
 

 

 Typical human eye will respond to wavelengths in air from about 380 to 750 nm 

 
http://en.wikipedia.org/wiki/Electromagnetic_spectrum 

 
 

 
 
 
 
 
 

The colours of the visible light spectrum[2] 

Colour wavelength interval frequency interval 

red ~ 630–700 nm ~ 480–430 THz 

orange ~ 590–630 nm ~ 510–480 THz 

yellow ~ 560–590 nm ~ 540–510 THz 

green ~ 490–560 nm ~ 610–540 THz 

blue ~ 450–490 nm ~ 670–610 THz 

violet ~ 400–450 nm ~ 750–670 THz 

 

http://en.wikipedia.org/wiki/Air
http://en.wikipedia.org/wiki/1_E-7_m
http://en.wikipedia.org/wiki/Electromagnetic_spectrum
http://en.wikipedia.org/wiki/Color#_note-1#_note-1
http://en.wikipedia.org/wiki/Red
http://en.wikipedia.org/wiki/Orange_%28colour%29
http://en.wikipedia.org/wiki/Yellow
http://en.wikipedia.org/wiki/Green
http://en.wikipedia.org/wiki/Blue
http://en.wikipedia.org/wiki/Violet_%28color%29
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